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Safety and Regulatory 
Compliance
For safe operation of the NGC system, Bio-Rad strongly recommends that you 

follow the safety specifications listed in this chapter and throughout this guide.

Safety Warning Labels

Warning labels posted on the instrument and WARNING and Caution notes listed 

in this guide warn you about sources of injury or harm. Review the meaning of each 

safety warning label.

Table 1. Explanations of safety warning labels

Icon Explanation

Shock hazard! This symbol draws attention to a possible injury or 

danger to life if the associated directions are not followed 

correctly. Only qualified, trained technicians should carry out 

service work on electronic components, due to potential shock 

hazard.

Risque d'électrocution! Ce symbole met en garde contre les 

risque possibles de blessure ou un danger pour la vie si les 

instructions fournies ne sont pas suivies correctement. Seuls des 

techniciens qualifiés et formés peuvent effectuer des réparations 

sur des composants électroniques en raison du risque 

d'électrocution.
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Safety and Regulatory Compliance
Risk of danger! This symbol identifies components that pose a 

risk of personal injury or damage to the instrument if the 

associated directions are not followed correctly. Wherever this 

symbol appears, consult this guide for further information before 

proceeding.

Risque de danger! Ce symbole identifie les composants qui 

présentent un risque de blessures ou de dommages pour 

l'instrument si les instructions ne sont pas suivies correctement. 

Lorsque ce symbole apparaît, consultez ce guide pour plus 

d'informations avant de continuer.

Laser hazard! This symbol draws attention to a possible injury or 

danger to life due to laser radiation if the associated directions are 

not followed correctly. Do not remove system covers, which are in 

place for your safety. Only qualified, trained technicians should 

access exposed laser beams.

Risque laser! Ce symbole attire l'attention sur un risque potentiel 

de blessure ou de danger pour la vie dû au rayonnement laser 

lorsque les instructions fournies ne sont pas suivies correctement. 

Ne retirez pas les caches de protection qui sont en place pour 

votre sécurité. Seuls des techniciens qualifiés et formés doivent 

accéder aux rayons laser exposés.

Biohazard! Biosafety is of utmost importance while operating this 

instrument. This symbol identifies components that may become 

contaminated with biohazardous material. When handling 

biohazardous samples or the NGC’s waste container, adhere to 

the recommended precautions and guidelines in this guide, and 

comply with any local guidelines specific to your laboratory and 

location.

Risque biologique! La biosécurité est d'une importance capitale 

lors de l'utilisation de cet instrument. Ce symbole identifie les 

composants qui peuvent être contaminés par des matières à 

risque biologique. Lorsque vous manipulez des échantillons 

biologiques ou le conteneur de déchets de l'analyseur de cellules 

NGC, respectez les précautions et directives fournies dans ce 

guide et respectez les directives locales spécifiques à votre 

laboratoire et à votre site.

Table 1. Explanations of safety warning labels

Icon Explanation
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Safe Use Specifications and Compliance

Electrical Safety Information and Classification

The NGC system conforms to international regulations encompassing the 

accessibility of high voltages by the user (IE61010–1). Use all protective housings 

and shields as specified in this guide. Further information about specific electrical 

hazards is listed in the hardware description.

AC Fuse Requirements

Remove power cord before replacing fuses. Fuses must be rated to AC250V, 4A.

AC Power Cord Requirements

Power cord must be IEC 60320–1 compliant with a C13 plug on the instrument end. 

If the power cord must be replaced, replace it with only an adequately rated cord.

Position the instrument for easy access to the power switch and the power cord.

AC Outlet Requirements

Two outlets (instrument and computer), AC100–240V, 50–60 Hz, <500W.

Regulatory Compliance

This instrument has been tested and found to be in compliance with all 

requirements of the following safety electromagnet standards:

 IEC 61010–1:2010 (3rd Ed), EN61010-1:2010 (3rd Ed). Electrical 

Equipment for Measurement, Control, and Laboratory Use - Part 1: 

General Requirements

 UL/CSA 61010–1:2012 (3rd Ed), Standard for Safety Electrical Equipment 

for Electrical Safety (USA, Canada, NRTL)

 IEC 61010–2–081:2015, EN61010-2-081:2015. Safety requirements for 

electrical equipment for measurement, control and laboratory use. 

Part 2-081: Particular requirements for automatic and semi-automatic 
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laboratory equipment for analysis and other purposes (includes 

Amendment 1)

 IEC 60825–1:2014, EN 60825–1:2014. Safety of laser products, Part 1: 

Equipment classification and requirements

 Class 1 laser product per IEC 60825–1 and CDRH requirements and 

regulations

 EN 61326–1:2013 (Class A) Electrical equipment for measurement, control 

and laboratory use. EMC requirements, Part 1: General requirements

 IEC 61326–1:2012 (Class A) Electrical equipment for measurement, control 

and laboratory use. EMC requirements, Part 1: General requirements

 FCC Part 15 Subpart B Emissions (Class A)

 This ISM device complies with Canadian ICES–001

Hazards

The NGC system is designed to operate safely when used in the manner prescribed 

by the manufacturer. If the NGC system or any associated component is used in a 

manner other than prescribed, or if modifications to the instrument are not 

performed by a Bio-Rad or other authorized agent, then the warranty on the system 

will be voided and the protection provided by the equipment might be impaired. 

Service of the NGC system should be performed only by Bio-Rad personnel.

Biohazards

The NGC system is a laboratory product. However, if biohazardous samples are 

present, adhere to the following guidelines and comply with any local guidelines 

specific to your laboratory and location.

General Precautions

 Always wear laboratory gloves, coats, and safety glasses with side shields 

or goggles.

 Keep your hands away from your mouth, nose, and eyes.
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 Completely protect any cut or abrasion before working with potentially 

infectious materials.

 Wash your hands thoroughly with soap and water after working with any 

potentially infectious material before leaving the laboratory.

 Remove wristwatches and jewelry before working at the bench.

 Store all infectious or potentially infectious material in unbreakable leak-

proof containers.

 Before leaving the laboratory, remove protective clothing.

 Do not use a gloved hand to write, answer the telephone, turn on a light 

switch, or touch anything that other people may touch without gloves.

 Change gloves frequently. Remove gloves immediately when they are 

visibly contaminated.

 Do not expose materials that cannot be properly decontaminated to 

potentially infectious material.

 Upon completion of the operation involving biohazardous material, 

decontaminate the work area with an appropriate disinfectant (for 

example, a 1:10 dilution of household bleach).

Disposal of Biohazardous Materials

Dispose of the following potentially contaminated materials in accordance with 

laboratory, local, regional, and national regulations:

 Content in waste container

 Reagents

 Used reaction vessels or other consumables that may be contaminated

Explosive or Flammability Hazards

The NGC system poses no uncommon hazard related to flammability or explosion 

when used in a proper manner as specified by Bio-Rad Laboratories.
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Electrical Hazards

The NGC poses no uncommon electrical hazard to operators when installed and 

operated properly without physical modification and if connected to a power source 

of proper specification.

Transport

Moving the NGC system is not recommended after installation. If the system must 

be moved, follow the decontamination procedure in this guide and remove all bulk 

fluidics. After a move, you must run the QC process to ensure that the instrument is 

functioning properly.

Caution: Lift the instrument with the inset handles on the base. To reduce the 

risk of personal injury or damage to the instrument, a minimum of two people 

must perform this task. Use caution to keep the instrument level, and handle 

the instrument gently.

Operating Conditions

The NGC system must be operated under the following conditions:

 Temperature range: 18–25°C

 Relative humidity: 20–60%

Disposal

The NGC system contains electronic or electrical materials; they should be 

disposed of as unsorted waste and must be collected separately, according to 

European Union Directive 2002/96/CE on waste and electronic equipment — WEEE 

Directive. Before disposal, contact your local Bio-Rad representative for country-

specific instructions.
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Warranty
Warranty

The NGC system and associated accessories are covered by a standard Bio-Rad 

warranty. Contact your local Bio-Rad Laboratories office for details of the warranty.
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1 Introduction
The NGC chromatography systems are preparative systems designed to rapidly 

automate the purification of biomolecules. The flexible, modular, and economical 

design makes NGC the instrument of choice for method development and scale-up. 

It is available in six preplumbed, factory-tested configurations at two different flow 

ranges. Each preconfigured system can be further customized and upgraded by 

adding valves, detectors, or pumps in order to meet specific application needs. Any 

system can be configured for either low flow rate or high flow rate operation by 

simply changing the system pump modules. As a result, a single hardware platform 

can be modified as the application need and scale change. 
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The NGC Chromatography Systems

The NGC chromatography systems are available in a series of combinations. Each 

system is available with either two 10 ml system pumps (the 10 series) or two 

100 ml system pumps (the 100 series).

Each system includes ChromLab software and the NGC touch screen.

 NGC Quest chromatography system includes

 Two system pumps

 Mixer

 Sample injection valve

 Conductivity monitor with a single-wavelength UV detector (on the NGC 

Quest system) or a multi-wavelength UV/Vis detector (on the NGC Quest 

Plus system) 

 NGC Scout chromatography system includes

 All modules on the NGC Quest system

Note: The NGC Scout system includes the single-wavelength UV 

detector, the NGC Scout Plus system includes the multi-wavelength 

UV/Vis detector.

 pH detector

 Buffer blending valve 

 NGC Discover chromatography system includes

 All modules on the NGC Scout system

Note: Only the multi-wavelength UV/Vis detector is available on the 

NGC Discover systems.

 Column switching valve

 Two buffer inlet valves

 Sample pump
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Main Features
 NGC Discover Pro chromatography system includes

 All modules on the NGC Discover system

Note: Only the multi-wavelength UV/Vis detector is available on the 

NGC Discover systems.

 Fourth expansion tier

 Sample inlet valve

 Outlet valve

Main Features

NGC chromatography systems enable you to do the following:

 Easily create purification and maintenance protocols from predefined 

method templates and protocol phases

 Automate multicolumn purification processes using preprogrammed 

templates and multiple column switching valves

 Automate multiple sample injections using either the sample inlet valve and 

the sample pump or the C-96 autosampler

 Expand sample monitoring using the signal import module (SIM) to export 

digital signals to, and import digital signals from, external detectors 

 Collect large-volume fractions using multiple outlet valves while also 

collecting small-volume fractions using the BioFrac fraction collector or 

NGC Fraction Collector

 Automatically prepare buffers using preprogrammed buffer blending 

protocols

 Analyze purification results through 1-click peak integration, determine 

protein concentration, and calculate column performance

 Automate purification protocol optimization using the scouting wizard

 Easily locate fractions containing peaks of interest and view the protein 

concentration within each fraction
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 Extend the preconfigured systems with additional valves for buffers, 

samples, and columns

 Organize the location of the modules to optimize separation performance 

based on method scale and complexity, and to minimize the system swept 

volume

 Minimize errors when connecting tubing using the Point-to-Plumb feature 

in ChromLab software

Site Requirements

Power Considerations

Note: The power supply to the NGC system must be stable and within 

specifications at all times to ensure optimal operation. The power cable 

connected to the power inlet port must be rated for 7 amps or more.

Table 1. Power requirements for the NGC system and ChromLab 

Parameter Requirement

Mains input voltage AC 100—240 V; 50—60 Hz

NGC maximum power usage 200—400 watts, dependent on system 

configuration

Number of power sockets Minimum of three power sockets:

 One socket for the NGC instrument

 One socket for the computer running 

ChromLab

 One socket for each fraction collector in 

use

  A socket for any supported peripheral 

instrument that you attach (for example, 

the C-96 autosampler or a second 

Bio-Rad fraction collector)

Tip:  The touch screen does not 

require a separate power supply.

Type of power sockets IEC type connections, grounded sockets
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Site Requirements
Environment

The NGC instruments are designed to work within temperatures of 4–40°C.

The small footprint makes the NGC instruments ideal for placement into standard 

cold cabinets. The touch screen can be detached and placed outside the cold 

cabinet to control the instrument without opening the cabinet door, preventing 

temperature fluctuations.

For specific temperature, humidity, and altitude ranges, see the NGC 

Chromatography Systems and ChromLab Software Installation Guide.

Bench Space

Ensure that the bench on which you install the NGC instrument is designed to 

support its weight and footprint dimensions.

For specific weight and footprint dimensions, see the NGC Chromatography 

Systems and ChromLab Software Installation Guide.
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Safety Requirements

This section explains the different safety alerts in this document. This section also 

provides information about the safe use and setup of the instrument.

Safety Alerts

This document contains WARNINGS and Cautions pertaining to the installation 

and use of the NGC instrument.

Safety Precautions

Caution: The weight of the NGC instrument varies from moderate to heavy 

depending on the system in place. Take care when lifting the instrument onto 

the lab bench or into the standard cold cabinet. To reduce the risk of personal 

injury or damage to the instrument, three or more people should perform this 

task.

WARNING!  Disconnect power to the NGC instrument before inserting, 

removing, or moving modules. No user-serviceable parts are inside any 

component unless noted in this manual. Refer servicing questions to Bio-Rad 

service personnel.

Alert Icon Definition

Flammable/

Extreme Heat

A hazardous situation that could result in 

serious personal injury or extreme damage to 

the instrument. Do not proceed until all 

stated conditions are met and clearly 

understood.

Electrical Shock A hazardous situation that could result in 

serious personal injury or extreme damage to 

the instrument. Do not proceed until all 

stated conditions are met and clearly 

understood.

A hazardous situation that could result in 

minor or moderate personal injury or damage 

to the instrument. Do not proceed until all 

stated conditions are met and clearly 

understood.
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Finding Out More

After you install NGC documentation from the NGC Chromatography Systems 

Software USB drive, you can access installed NGC guides and tutorials on the Help 

menu in any ChromLab view.

More information about the NGC chromatography systems and ChromLab software 

is available from the following sources.

 The NGC Chromatography Systems and ChromLab Software Installation 

Guide is available on your NGC Chromatography Systems Software USB 

drive as a .pdf file. This guide explains how to set up your environment, set 

up and install the NGC instrument in the lab, install ChromLab software, 

and connect ChromLab to the NGC system.

 The NGC Chromatography Systems and ChromLab Software User Guide 

is available on your NGC Chromatography Systems Software USB drive as 

a .pdf file. This guide explains how to use ChromLab software to set up 

and control the NGC instrument, run protein separations and other 

operations manually, program methods to automate purification runs, 

evaluate the results, and print experiment reports.

 For ChromLab Help, clicking  in dialog boxes accesses relevant 

information. Screen-level help is also available on the Help menu.

 NGC video tutorials are available on the NGC Chromatography Systems 

Software USB drive as .mp4 files.

Tip:  You can click the Bio-Rad logo in the upper left corner of any 

ChromLab window to launch the Bio-Rad website.
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2 The NGC Instrument
The NGC instrument ships preassembled with the components necessary to 

perform gradient separations. The modular components slide into slots in the 

system known as bays. Some modules fit into single-wide bays while others require 

double-wide bays. Bays can be converted from one size to the other by adding or 

removing a center divider.

Each module has a unique electronic ID that enables the system to recognize its 

function when the module is placed into a bay. For example, the system can 

distinguish between a sample inject valve module and a sample inlet valve module 

even though they each occupy a single-wide slot.

The position of the module on the system can be changed to optimize the 

placement and minimize the length of tubing, reducing the system swept volume. 

The physical location of a module can be easily identified in the overall flow scheme 

required to run the application through the ChromLab software. Prior to starting a 

run, ChromLab performs a system check to ensure that all the required modules are 

physically present on the instrument.

This chapter explains in detail the modules that make up the NGC instrument.
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The NGC Instrument Illustrated

The illustrations in this section display the main components of the 

NGC Discover Pro chromatography system:

 Front View

 Back View

 Right Side View

 Left Side View

Note: Your system might not include all the modules shown in these 

illustrations. For a list of modules on the NGC Quest, NGC Scout, and 

NGC Discover chromatography systems, see Table 10 on page 99.
28  |  NGC Chromatography Systems and ChromLab Software



The NGC Instrument Illustrated
This page is intentionally blank.
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Front View
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The NGC Instrument Illustrated
LEGEND

1 Touch screen monitor 2 Sample pump

3 Sample inlet valve 4 Buffer tray

5 Empty bay, covered 6 LED display

7 Integrated multi-wavelength  

UV/Vis detector and conductivity 

monitor

8 Outlet valve

9 pH detector 10 Column and peripheral mount

11 Columns 12 Column grip

13 Column-switching valve 14 Buffer inlet B

15 Peripheral ports 16 USB ports and soft power switch

17 System pump B 18 Drip tray

19 Mixer 20 Buffer blending valve

21 System pump A 22 Buffer inlet A

23 Inject valve 24 Touch screen mounting arm
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Back View

LEGEND

1 Cable connector port/hand grip 2 Cable connector port

3 Touch screen arm 4 Touch screen connector cable

5 Cable connector port/hand grip 6 Instrument’s serial number label

7 Touch screen connector port 8 Ethernet connector port

9 Power outlet ports 10 Power inlet port

11 Fuse cover 12 Power on/off switch
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The NGC Instrument Illustrated
Right Side View

LEGEND

1 Drain hole 2 Peripheral port 

3 Peripheral ports 4 USB ports

5 Soft power switch 6 Drip tray

7 Touch screen cable cover 8 Air sensor module

9 Column and peripheral mount 
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Left Side View

LEGEND

1 Buffer tray 2 Drain hole

3 Touch screen cable cover 4 USB ports

5 Peripheral port 6 Peripheral ports

7 Vents
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The NGC Instrument Illustrated
Liquid Flow Path of the NGC Discover Pro System

At startup, ChromLab displays a default fluidic scheme in the System Control tab 

(as well as in the Method Editor tab and on the touch screen). The fluidic scheme 

depicts the plumbing flow for the modules. The image that follows displays the 

plumbing flow of the modules in the NGC Discover Pro system during a sample run. 

The modules in the fluidic scheme are described in detail in the sections that follow.

To view or modify module parameters during a manual run

 Click the module to access its dialog box.

Alternatively, select the module on the touch screen to access its dialog box.

Tip:  For more information about using ChromLab, see the NGC 

Chromatography Systems and ChromLab Software User Guide.          

LEGEND

1 System pumps A and B 2 Buffer inlet valves A and B

3 Buffer blending valve 4 Sample pump with pressure sensor

5 Sample inlet valve 6 Manual inject syringe

7 Sample inject valve 8 Waste (not provided)

9 Sample loop 10 Column switching valve

11 Column (not provided) 12 Multi-wavelength UV/Vis detector

13 Conductivity monitor 14 pH valve

15 Outlet valve 16 Fraction collector (separate instrument)

17 Waste (not provided)
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Pumps

The NGC systems can have up to three high-precision pumps: two system (or 

gradient) pumps (pump A and pump B) and one sample pump. The system pumps 

can create isocratic or linear gradients at a range of precisely controlled flow rates 

and pressures. The sample pump can load large sample volumes onto a column or 

fill large sample loops. Flow rates on all pumps can be controlled to avoid 

overpressure.
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Pumps
System Pumps

The system pumps perform isocratic or gradient elution at the specified flow rates.

LEGEND

1 Pump flow status LED 2 Priming port

3 Module name 4 LED screen

5 Purge/pause buttons 6 Pump outlet port

7 Pump head 8 Pump inlet port
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Detailed Attributes

The NGC systems include two system pumps: pump A (the left pump) and pump B 

(the right pump). The system pumps are available in two flow rates: 10 ml/min (the 

F10 pumps) and 100 ml/min (the F100 pumps).

F10 Pump

 Flow rate delivery: 0.001–10 ml/min specified

 Operating pressure range: 0–3,650 psi (0–25.2 MPa)

 Operating viscosity range: 0.35–10 cP

F100 Pump

 Flow rate delivery: 0.01–100 ml/min specified

 Operating pressure range: 0–1,450 psi (0–10 MPa)

 Operating viscosity range: 0.35–10 cP

System Pump LEDs

Each system pump module is fitted with LEDs.

 Green LEDs indicate the pump is in use.

How the System Pumps Function

Each NGC system ships with either two F10 pumps or two F100 pumps. The 

reciprocating pistons in each pump synchronize to deliver continuous flow with low 

pulsation. On the NGC Quest system (without a buffer blending valve), the system 

pumps operate such that the sum of the flow rates of pump A and pump B is equal 

to the maximum delivery rate. For example, if the flow of an F10 pump A equals 10 

ml/min, then the rate for the F10 pump B must equal 0 ml/min. If the system is set to 

deliver 5 ml/min with a gradient mixture of 50% B, pump A and pump B each run at 

2.5 ml/min.
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Pumps
Each system pump module has an emergency Pause button and a Purge button.

 Pressing the emergency Pause button on either system pump stops both 

pumps. If a run is in progress when you press Pause on either system 

pump, both system pumps stop and the run pauses.

You can resume or cancel the run through ChromLab. If you choose to cancel 

the run, you can save the run data up to that point.

 Pressing Purge on a system pump runs that pump at full speed, replacing 

any air in the lines with buffer. Purge activates purging for the tubing lines 

that belong to that specific pump. For instance, when you press Purge on 

system pump A, pump A runs at maximum flow rate while pump B 

becomes idle. If you press Purge on pump B while pump A is purging, the 

purge on pump A stops and the purge on pump B starts. The Purge button 

is a toggle. To stop the purge, press Purge on that system pump again.

Note: The Purge button is deactivated when:

 A run is in progress 

 Any of the modules are in calibration mode

 The buffer blending valve is included in the fluidic scheme

Caution: To avoid damaging the column, always ensure that it is offline 

when purging the system. Set the inject valve to waste, or remove the 

column from the system and replace with a union fitting.

Tip:  You can pause the system through ChromLab using either the touch 

screen or the computer running ChromLab (known in this document as the 

ChromLab computer). You can also set timed purging of both pumps through 

ChromLab, which will set the inject valve to Waste for a set amount of time. For 

more information, see the NGC Chromatography Systems and ChromLab 

Software User Guide.

Pump Priming Port

The pump priming port introduces fluid into, and removes air from, the inlet tubing 

line and the pump head.
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Piston Wash System

The pumps on the NGC system automatically rinse behind the piston with a 

constant low flow of 20% ethanol. This prolongs the working lifetime of the seal by 

keeping the seal wetted and preventing salt crystals from depositing onto the 

pistons.

When the pumps are running, the pistons and the check valve located in each 

chamber automatically pump the rinse fluid, which circulates through the system. 

The tube holders on the side of the instrument hold two conical rinsing solution 

reservoirs, one for the system pumps and one for the sample pump (if present). The 

inlet and outlet tubing for the system pumps piston wash housing is immersed in 

one of the rinsing solution reservoirs. The inlet and outlet tubing for the sample 

pump is immersed in the second rinsing solution reservoir. The tubing connects to 

the wash housing ports at the back of the pump heads. 

Important: Change the rinse fluid weekly. Place the washing system reservoir 

at the same height or above the level of the pump heads to avoid siphoning of 

the solution back to the reservoir. Ensure that the inlet tubing reaches the very 

bottom of the rinsing solution reservoir. 
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Sample Pump

The sample pump is used to automatically load large sample volumes onto a 

column or to automatically fill large sample loops. When sample inlet valve modules 

are installed along with the sample pump, the sample pump performs as an 

autosampler and enables the system to load multiple samples automatically. 

The sample pump includes an integrated pressure sensor that protects the column 

and media from overpressure. The performance specifications for the sample pump 

are the same as the specifications for the F100 system pump module.

The sample pump ships with two check valves to insert into the waste ports on the 

sample inject valve. The check valves are used to apply positive backpressure to 

the waste ports on the sample inject valve. For information about inserting the 

check valves, see Inserting Check Valves into the Sample Inject Valve on page 108.

LEGEND

1 Pump flow status LED 2 Priming port

3 Module name 4 LED screen

5 Purge/pause buttons 6 Pump outlet port

7 Pump head 8 Pump inlet port
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Detailed Attributes

 Flow rate delivery: 0.01–100 ml/min

 Pressure range: 0–1,450 psi (0–10 MPa)

 Operating viscosity range: 0.35–10 cP

Sample Pump LEDs

The sample pump module is fitted with LEDs.

 Blue LEDs indicates the pump is in use.

How the Sample Pump Works

The reciprocating pistons in the sample pump synchronize to deliver continuous 

flow with low pulsation. The sample pump module also has an emergency Pause 

button and a Purge button.

 Pressing the emergency Pause stops the sample pump. If a run is in 

progress when you press Pause, the sample pump stops and the run 

pauses.

You can resume or cancel the run through ChromLab. If you choose to cancel 

the run, you can save the run data up to that point.

 Pressing Purge runs the sample pump at full speed, replacing any air in the 

lines with buffer. The Purge button is a toggle. To stop the purge, press 

Purge on the sample pump again.

Note: The Purge button is deactivated when a run is in progress or when 

any of the modules are in calibration mode.

Caution: Always ensure that the column is offline when purging the 

system in order to avoid damaging the column.
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Tip:  You can pause the system through ChromLab using either the touch 

screen or the ChromLab computer. You can also set timed purging of the 

sample pump through ChromLab, which will set the inject valve to Waste for a 

set amount of time. For more information, see the NGC Chromatography 

Systems and ChromLab Software User Guide.
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Valves

All NGC systems include a sample inject valve. Your system might also include one 

or more of the following valves:

 Buffer blending valve 

 Buffer inlet valve

 Sample inlet valve

 Outlet valve

 Column switching valve

All valves (except the buffer blending valve) are motorized rotary valves with a 

number of defined inlet and outlet ports. As the rotary valve turns, the flow path for 

the valve changes. The active ports are identified by LEDs. Green LEDs indicate that 

the flow through the port is from the system pumps. Blue LEDs indicate that the 

flow is from the sample pump. The pattern and location of the ports determine the 

flow path and function of each type of valve.

Tip:  Bio-Rad recommends inserting a Delrin or Tefzel 1/4–28 flat-bottom plug, 

included in the fittings kit, into unused valve ports to prevent particles from 

entering the valve.
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Sample Inject Valve

The sample inject valve enables the system to load a specific, predetermined 

volume of sample onto a column. 

When the sample pump is installed, the sample inject valve enables the system to 

easily switch between manual loop filling, automated loop filling, and direct sample 

injection onto a column without replumbing the fluidic connections.

You can use the sample pump to load sample either directly onto a column or into a 

sample loop.

Detailed Attributes

 Maximum operating pressure is 3,650 psi
Instrument Guide  |  45



2  |  The NGC Instrument
Ports on the Sample Inject Valve

 

Port Function

Inject Manually load sample using a syringe

Column Outlet to top of column

Pump Inlet from the system pump

Loop E  Inject: Inlet for buffer

 Load: Outlet to waste

Waste 1 Outlet to waste (from the sample pump and sample loop)

Sample pump Inlet from the sample pump

Loop F  Inject: Outlet to column

 Load: Inlet for the sample

Waste 2 Outlet to waste (from the system pump)
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Sample Inject Valve LEDs

The sample inject valve module is fitted with LEDs.

 Solid green LEDs indicate the flow is from the system pump.

 Solid blue LEDs indicate the flow is from the sample pump.

 Blinking green LEDs indicate the line to plumb using the Point-to-Plumb 

feature.

How the Sample Inject Valve Works

The sample inject valve enables sample to be loaded onto the column. Several 

sample application techniques are available:

 The sample loop can be manually filled with sample using a syringe 

followed by injection onto a column by the system pumps

 The sample loop can be filled with sample using the sample pump (if 

installed) followed by injection onto a column by the system pumps

 Sample can be injected directly onto the column using the sample pump (if 

installed)

Flow Paths of the Sample Inject Valve 

In Manual mode (from the System Control tab in ChromLab), you can manually 

change the flow path of the sample inject valve from its dialog box.

The following images show the different flow paths of the sample inject valve.

LEGEND

Manual injection flow

System pump flow

Sample pump flow

No flow
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Valve Position Explanation

Manual Load Loop/System Pump to Column

 Directs system pump flow directly 

toward the column

 Aligns the sample loop with manual 

injection port so that sample can 

be manually filled into the loop 

using a syringe. Excess sample 

goes out waste port (W1)

 Chromatogram x-axis based on 

system pump flow rate

System Pump Inject Loop/Sample Pump Waste

 Directs system pump flow through 

the sample loop to load the sample 

from the loop onto the column

 Directs sample pump flow to waste 

(W2)

 Chromatogram x-axis based on 

system pump flow rate
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Sample Pump Direct Inject/System Pump Waste

 Directs system pump flow to waste 

(W2)

 Directs sample pump flow directly 

onto the column to load large 

volumes of sample

 Chromatogram x-axis based on 

sample pump flow rate

Sample Pump Load Loop/System Pump to Column

 Directs system pump flow directly 

onto the column

 Directs sample pump flow into the 

loop to load the loop with sample. 

Excess sample flows out through 

waste port (W1)

 Chromatogram x-axis based on 

system pump flow rate

Valve Position Explanation
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Buffer Blending Valve 

The buffer blending valve is used for automatic online buffer preparation. The buffer 

blending valve blends buffers to a specific pH using standard acid and base buffer 

solutions. This enables automated pH scouting without manually preparing buffers 

at various pH values. The buffer blending valve titrates the appropriate amounts of 

the acid and base stock solutions to produce buffers at the required pH values. 

Because salt concentration can affect pH, the blending algorithm takes into account 

the salt concentration for accurate pH blending.

Stock solutions of four buffers are connected to the inlets. The buffer blending valve 

can be connected directly into the inlet of the system pumps or to port 8/BB on the 

buffer inlet valves. In addition to buffer blending, the buffer blending valve can be 

used to double the allowed flow rate of a salt gradient (for example, up to 20 ml/min 

on an F10 system pump and 200 ml/min on an F100 system pump).

The buffer blending valve can be plumbed to two buffer inlet valves, each 

connected to seven different buffers. The system can switch between blending 

mode and simple salt gradients without replumbing.
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Detailed Attributes

 Operating pressure up to 15 psi
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Ports on the Buffer Blending Valve

 

Buffer Blending Valve LEDs

The buffer blending valve module is fitted with LEDs.

 A single green LED indicates the active inlet port is open.

 Multiple green LEDs indicate the buffer blending valve is cycling between 

the inlet ports.

 A green LED indicates the active outlet port.

 Blinking green LEDs indicate the line to plumb using the Point-to-Plumb 

feature.

Port Function

Q1–Q4 Buffer inlet ports

Outlet A Outlet to system pump A or to buffer inlet valve A

Outlet B Outlet to system pump B or to buffer inlet valve B
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How the Buffer Blending Valve Works

The buffer blending valve operates in two modes: buffer blending and gradient.

Buffer Blending Mode

Acid, base, water, and salt are blended together in the required proportions to form 

a buffer of specified pH over a linear salt gradient, or a pH gradient at a specified 

salt concentration. The suggested buffer solution for each port is 

 Q4 — high salt buffer solution (green inlet tubing)

 Q3 — water (yellow inlet tubing)

 Q2 — buffer base (blue inlet tubing)

 Q1 — buffer acid (orange inlet tubing)

The Q1 and Q2 acid and base are selected depending on the buffer system being 

used.

Gradient Mode

The buffer blending valve enables both pumps simultaneously to run up to their 

maximum flow rate, doubling the available flow-rate range for creating gradients. 

This is possible because gradients are formed by the proportioning actuation of the 

individual Q1 and Q4 valves rather than proportioning the pump speed as in 

two-pump gradient mode.

Note: Only ports Q1 and Q4 are used in gradient mode.
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Inlet Valves

The inlet valves automate the use of multiple buffers and samples during method 

development. In ChromLab, you can program the inlet valves to

 Switch between buffers during a method run

 Automate sample selection and loading by way of the sample pump

 Switch between cleaning solutions and buffers during system wash and 

preparation

The inlet valve has eight defined inlet ports and one outlet port. The active ports are 

identified by green LEDs for the buffer inlet valve and blue LEDs for the sample inlet 

valve. In ChromLab you can provide a custom label for each port to easily identify it 

during method protocol programming.

Tip:  In Manual mode (accessed from the System Control tab in ChromLab), 

you can select a specific port on the buffer inlet valve through its dialog box. To 

open the dialog box, touch or click the inlet valve in the fluidic scheme. When 

the buffer blending valve is present, touch or click the pump/valve module to 

access the positions on the buffer inlet valves. To access the positions on the 

sample inlet valves, touch or click the sample pump module in the fluidic 

scheme.
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Inlet Valve

Detailed Attributes

 Maximum operating pressure: 500 psi 

 Optional air sensors indicate the end of buffer or sample injection

See Air Sensors on page 93 for specific information about the air sensors.

Tip:  In ChromLab, you can customize the names of ports on each inlet valve. 

For example, you might change the name to reflect the sample or buffer that is 

associated with that position.

For more information, see the NGC Chromatography System and ChromLab 

Software User Guide.
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Ports on the Inlet Valves

Buffer Inlet Valve

Sample Inlet Valve

Port Function

1–7 Buffer inlets

8/BB 8: Inlet for systems without the buffer blending valve

BB: Reserved inlet for systems with the buffer blending valve

Out Outlet port

One sample inlet valve in fluidic scheme

Port Function

1–8/BB Sample inlets

Out Outlet port to sample pump
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Inlet Valve LEDs

The inlet valve modules are fitted with LEDs.

 Solid green LEDs indicate the flow is from the system pump.

 Solid blue LEDs indicate the flow is from the sample pump.

 Blinking green LEDs indicate the line to plumb using the Point-to-Plumb 

feature.

 The Outlet LED is lit when the valve is in use.

 When one sample inlet valve is in line, a single LED indicates the active 

inlet port.

 When two sample inlet valves are in line and sample flows from S2:

 Both Outlet LEDs are lit.

 The LED on the active port on S2 is lit.

 The 8/BB on S1 is lit.

Two sample inlet valves (S1 and S2) in fluidic scheme

Valve Port Function

S1 and

S2

1–7 Sample inlets

S1

S2

8/BB Inlet from sample inlet valve 2

Sample inlet

S1

S2

Out Outlet to sample pump

Outlet to S1
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How the Inlet Valves Work

The function of an inlet valve is determined by the type of pump to which it is 

connected. Inlet valves connected to the system pumps are used for buffers and are 

referred to as buffer inlet valves. Inlet valves connected to the sample pump are 

used for samples and are referred to as sample inlet valves.

Buffer Inlet Valve

The NGC systems support the use of up to two buffer inlet valves. Systems with 

buffer inlet valves that also include a buffer blending valve require two buffer inlet 

valves. This enables the system to switch between buffer blending and simple 

gradients without replumbing. In this configuration, the buffer inlet valves are 

located between the buffer blending valve and the system pumps. The buffer 

blending valve connects to the inlet valves through port 8/BB on each valve. The 

outlet of each inlet valve flows to system pumps A and B. The seven ports on each 

buffer inlet valve can be connected to buffers that can be used to create simple salt 

gradients.

In the absence of the buffer blending valve, eight buffers can be connected to the 

inlet port of each system pump.

Sample Inlet Valve

The NGC system supports the use of up to two daisy-chained sample inlet valves. 

The sample inlet valve is connected to the inlet port of the sample pump to serve as 

an autosampler for a small number of samples. This configuration is ideal for 

automated processing of multiple large-volume samples. When two sample inlet 

valves are used, the first sample inlet valve, S1, is connected directly to the sample 

pump. The second valve, S2, is connected to port 8 on S1. In this configuration, the 

system can switch between up to seven samples on S1 and eight different samples 

on S2 for a total of up to 15 samples.

Tip:  Port 8 on S2 in the daisy-chain configuration (or on S1 if using a single 

sample inlet valve) is the default port for buffer solution required to wash out the 

valve and pump between sample injections.
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Outlet Valve

The outlet valve enables the system to direct the flow to the BioFrac fraction 

collector, to the NGC Fraction Collector (known as the NGC FC), to waste, or to 

another user-defined location. The outlet valve enables the system to connect to up 

to two fraction collectors:

 One BioFrac fraction collector and one NGC FC

 Two NGC FCs

Note: The system does not support two BioFrac fraction collectors.

The outlet valve has 12 defined outlet ports and one inlet port. The active ports are 

identified by LEDs. Green LEDs indicate that the flow through the port is from the 

system pumps. Blue LEDs indicate that the flow is from the sample pump. The 

outlet valve enables the system to collect large-volume fractions. This can be done 

in conjunction with collecting small-volume fractions on the BioFrac fraction 

collector and large- and small-volume fractions on the NGC FC.

The outlet valve also enables the system to perform multi-dimensional 

chromatography by directing column eluates to a loop valve prior to injection onto 

the next column.

Tip:  In Manual mode (from the System Control tab in ChromLab), you can 

change the port on the outlet valve through which to direct the flow. To open 

the Outlet Valve dialog box, touch or click the outlet valve in the fluidic scheme.
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Detailed Attributes

 Maximum operating pressure is 500 psi (3.4 MPa)
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Valves
Ports on the Outlet Valve

 

One outlet valve in fluidic scheme

Port Function

1  Outlet to the diverter valve on the first fraction collector (if included in 

the fluidic scheme)

  Outlet to waste (if the fluidic scheme does not include a fraction 

collector)

2  Outlet to the diverter valve on the second fraction collector (if included in 

the fluidic scheme)

  Fraction outlet (if the fluidic scheme does not include a second fraction 

collector)

3–12 Fraction outlets

In Inlet port from the (UV detector/conductivity monitor or pH monitor
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Outlet Valve LEDs

The outlet valve modules are fitted with LEDs.

 Solid green LEDs indicate the flow is from the system pump.

 Solid blue LEDs indicate the flow is from the sample pump.

 Blinking green LEDs indicate the line to plumb using the Point-to-Plumb 

feature.

 The Inlet LED is lit when the valve is in use.

 When one outlet valve is in line, a single LED indicates the active outlet 

port.

Two outlet valves (O1 and O2) in fluidic scheme

Valve Port Function

O1 1  Outlet to the diverter valve on the first fraction collector (if 

included in the fluidic scheme)

 Outlet to waste (if the fluidic scheme does not include a 

fraction collector)

O1 2  Outlet to the diverter valve on the second fraction collector (if 

included in the fluidic scheme)

 Fraction outlet (if the fluidic scheme does not include a 

second fraction collector)

O1 3–11

12

Fraction outlets

Outlet to O2 inlet port

O1 In Inlet port from the (UV detector/conductivity monitor or pH 

monitor

O2 1–12 Fraction outlets

O2 In Inlet from O1
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 When two outlet valves are in line and the flow goes through O2:

 Both Inlet LEDs are lit.

 Port 12 on O1 is lit.

 The LED on the active outlet port on O2 is lit. 

How the Outlet Valve Works

The NGC system supports the use of up to two daisy-chained outlet valves. This 

configuration is ideal for collecting large-volume fractions.

The inlet port on the first outlet valve (O1) connects to the outlet port of either the 

conductivity monitor or the pH detector. Port 1 on O1 connects to the diverter valve 

on the fraction collector or directs the flow to waste. When two outlet valves are 

present, port 12 on O1 connects to the inlet port of the second outlet valve (O2). 

When one outlet valve is present, it can collect up to 11 fractions. When two outlet 

valves are present, they can collect up to 22 fractions: O1 can collect up to 10 

fractions; O2 can collect up to 12 fractions.

Tip:  To clean the outlet valve, immerse the outlet lines in a waste container 

and the inlet line in cleaning solution. Perform the system wash step in 

ChromLab as explained in the section System CIP (Clean in Place) — Storage 

Parameters in the NGC Chromatography Systems and ChromLab Software 

User Guide.
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Column Switching Valve

The NGC system supports up to three column switching valves. Each column 

switching valve is used to connect up to five columns simultaneously, supporting up 

to 15 columns. This enables automated column scouting, and the use of different 

columns without connecting and disconnecting the columns. The valve includes an 

internal bypass mode, which enables buffers to bypass the connected columns 

when necessary (for example, when priming or cleaning the system). The valve can 

also reverse the flow, which is optimal for certain separations where elution in a 

narrow band is necessary. Reverse flow is also useful when cleaning a column. 

The column switching valve has one inlet port, one outlet port, and five pairs of 

column connection ports. In ChromLab you can program the method to 

automatically change the position of the valve. The active ports are identified by 

LEDs. 

The column switching valve has two internal pressure sensors. ChromLab displays 

the precolumn and delta pressure values. The pressure values are viewed as traces 

on the chromatogram. When two or three column switching valves are present, the 

NGC system monitors the delta pressure from all columns that are inline. 

Overpressure events are triggered when any of the delta pressures reaches its 

maximum specified limit.
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Detailed Attributes

 Maximum operating pressure: 3,650 psi 

 Dual pressure sensors for precolumn and delta pressure detection

 Internal bypass capability

 Reverse flow capability
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Ports on the Column Switching Valve

      

Port Function

Top 1–5 Ports to connect to the top of columns

Bottom 1–5 Ports to connect to the bottom of columns

In Inlet port from the system pump through precolumn pressure sensor

Out Outlet port through the postcolumn pressure sensor to the UV 

detector
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Column Switching Valve LEDs

The column switching valve modules are fitted with LEDs.

 Solid green LEDs indicate the flow is from the system pump in the forward 

direction.

 Blinking green LEDs indicate the flow is from the system pump in the 

reverse direction.

 Solid blue LEDs indicate the flow is from the sample pump in the forward 

direction.

 Blinking blue LEDs indicate the flow is from the sample pump in the 

reverse direction.

 Blinking green LEDs indicate the line to plumb when using the 

Point-to-Plumb feature.

How the Column Switching Valve Works

The NGC system supports up to three column switching valves. Each column 

switching valve enables you to select from up to five attached columns. The top of 

the column connects to a numbered port labeled Top. The bottom of the column 

connects to the corresponding numbered port labeled Bottom. The active ports are 

identified by LEDs.

By default (and for most applications) the buffer flows from the top of the column to 

the bottom. When you select Reverse Flow in ChromLab, the flow travels from the 

bottom to the top of the column. This is useful for column cleaning and applications 

that require elution of concentrated bands. When the flow is reversed, the LEDs on 

the active ports blink green when the reverse flow through the port is from the 

system pumps. The LEDs blink blue when the flow is from the sample pump.

The column switching valve has three flow paths:

 Bypass

 Forward flow

 Reverse flow
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The section Flow Paths of the Column Switching Valve explains the specific flow 

paths.

The column switching valve has integrated precolumn and postcolumn pressure 

monitors. The precolumn pressure monitor measures the pressure that the system 

exerts on the column (precolumn pressure). The postcolumn pressure monitor 

measures the pressure at the column outlet and provides the delta pressure across 

the column. In Manual and Method modes, you can set alarms that cause the 

pumps to stop or slow down when a pressure sensor on the column switching valve 

detects an overpressure event.

Flow Paths of the Column Switching Valve

During a manual run, you can change the flow path of the column switching valve by 

accessing its dialog box in ChromLab.

To change the flow path of the column switching valve

1. Touch or click the Column Switching Valve module in the fluidic scheme to 

access its dialog box.

2. In the Column Switching Valve dialog box, select the port to which your column 

is connected or through which you want to direct the flow of buffer.
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Valves
 Select Bypass to bypass the flow past all ports.

 Select Reverse Flow Direction to reverse the flow so that it flows from the 

bottom to the top of the column.
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Mixer 

The mixer module consists of a mixer assembly and an integrated system pressure 

sensor. This module homogenizes the buffers proportioned by the two system 

pumps and the buffer blending valve (if present). The pressure sensor, located in this 

module, monitors the NGC system pressure.

The mixer module is located between the two system pumps (A and B). It is 

plumbed so that flow from the two system pumps

1. Enters at the mixer assembly base

2. Exits the mixer assembly top

3. Passes through the system pressure sensor

4. Flows to the inject valve
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Mixer
During operation, the system pressure sensor continuously measures and records 

the pressure. If the system pressure exceeds user- or system-specified pressure 

limits, the system pumps shut down. Alternatively, when you select the option in 

ChromLab to control the flow to avoid overpressure, the NGC system reduces the 

flow rate until the system is within safe operation pressure limits. See F10 Pump on 

page 38 and F100 Pump on page 38 for specific pressure limitations.

LEGEND

1 Mixer outlet port 2 Mixer barrel

3 Inlet from system pump B 4 Mixer base assembly

5 Inlet from system pump A 6 Pressure transducer port
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Detailed Attributes

The mixer is composed of a base motor, a stirring plate, and a hollow mixer barrel in 

which the buffers are mixed. An optional mixer barrel extender is available to adapt 

the mixer volume to the flow rate used. Bio-Rad offers several different mixer 

chamber sizes for different flow rates. Table 2 and Table 3 list the recommended 

barrel sizes for different flow rates for each type of system pump. To change the 

barrels, see Replacing the Mixer Components on page 204.

Tip:  For liquids that are difficult to mix, use a mixer barrel with a higher 

capacity.

Table 2. Flow rates of supported mixer barrels for the F10 pumps

Mixer Barrel Size Flow Rate Range, ml/min

Without buffer blending valve
(gradient)

With buffer blending valve

263 μl (base) .01–1.00 0.1–1.99

750 μl 1.00–9.99 2.00–5.99

2 ml 10.00–20.00 6.00–11.99

5 ml n/a 12.00–20.00

Table 3. Flow rates of supported mixer barrels for the F100 pumps

Mixer Barrel Size Flow Rate Range, ml/min

Without buffer blending valve
(gradient)

With buffer blending valve

750 μl (base) 1.00–4.99 <5.00

2 ml 5.00–14.99 5.00–11.99

5 ml 15.00–39.99 12.00–39.99

12 ml 40.00–100.00 40.00–80.00
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Mixer LEDs

The mixer module is fitted with LEDs.

 A left green LED indicates the flow is from system pump A.

 A right green LED indicates the flow is from system pump B.

 Both LEDs light when both pumps are running.

 Blinking green LEDs indicate the line to plumb using the Point-to-Plumb 

feature.

Detectors

All NGC systems include a detector module that contains a conductivity monitor 

and either a single-wavelength UV detector or a multi-wavelength UV/Vis II detector. 

The single-wavelength UV detector and conductivity module can be replaced with 

an integrated multi-wavelength UV/Vis detector/conductivity module and vice versa. 

Some configurations include a pH detector module. The pH detector module can be 

added as an upgrade to systems that do not offer it as a standard module.

UV Detectors and Conductivity Monitor

The UV detectors measure the UV absorbance of biomolecules as they elute 

through the column. The conductivity monitor measures the ionic strength (salt 

concentration) of buffers.
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Single-Wavelength UV Detector and Conductivity Monitor

Multi-Wavelength UV/Vis Detector with Integrated Conductivity Monitor II
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Detectors
Multi-Wavelength UV Detector and Conductivity Monitor
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Single-Wavelength UV Detector

Detailed Attributes

 Two integrated LED UV bulbs

 LED operating usage: approximately 5,000 hours

Note: If the reference output is below 0.9 volts you might need to replace 

the LED bulbs depending on the requirements of the experiment. 

For information about changing the LED bulbs, see Replacing the Single-

Wavelength UV Detector LED on page 225.

LEGEND

1 Conductivity monitor 2 LED display

3 UV flow cell 4 UV detector housing

5 Point-to-Plumb indicator
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Detectors
 Monitors UV absorbance one wavelength at a time

 255 nm 

 280 nm (default)

Tip:  Use ChromLab to change the absorbance wavelength values. For 

more information, see the NGC Chromatography Systems and ChromLab 

Software User Guide.

 UV absorbance range: 0–3,000 mAU

 UV linearity: ±5%

 Three interchangeable flow cells with path lengths of 2 mm, 5 mm (default), 

and 10 mm; see Table 5 on page 81 for specific information

Note: Use the preparative 2 mm flow cell to measure high concentrations 

of protein. The path lengths of the analytical 5 mm and 10 mm flow cells 

are longer and are appropriate for measuring lower concentrations of 

protein.

For information about changing the flow cells, see Replacing the UV Flow Cell 

on page 214.
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Multi-Wavelength UV/Vis Detector II

Detailed Attributes

 Contains one deuterium and one tungsten lamp

 Lamp operating usage: approximately 2,000 hours for the deuterium bulb 

and 1,000 hours for the tungsten bulb

For information about changing the UV lamps, see Replacing the Multi-

Wavelength UV/Vis Detector Lamps on page 233.

Tip:  To conserve lamp life, in Manual mode open the Multi Wave Detector 

dialog box and turn off the UV/Vis lamps when the instrument is not in use.

LEGEND

1 Detector head 2 Combination UV flow cell and 

conductivity monitor unit

3 Optical base
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Detectors
 Monitors up to four wavelengths in the UV/Vis range of 190–800 nm

Tip:  Use ChromLab to change the absorbance wavelength values. For 

more information, see the NGC Chromatography Systems and ChromLab 

Software User Guide.

 UV absorbance range: 0–3,000 mAU

 UV linearity: 2,800 mAU

 Three interchangeable flow cells with path lengths of 2 mm, 5 mm (default), 

and 10 mm; see Table 5 for specific information

For information about changing the flow cells, see Replacing the Multi-

Wavelength UV/Vis II Flow Cell on page 214.

Note: Use the preparative 2 mm flow cell to measure high concentrations 

of protein. The path lengths of the analytical 5 mm and 10 mm flow cells 

are longer and are appropriate for measuring lower concentrations of 

protein.

Integrated Conductivity Detector

Detailed Attributes

 Factory specified range: 0.01–999.9 mS/cm

 Validated working range: 0.01–300 mS/cm

 Accuracy: ±2%

Table 4. Pressure limits of UV detector flow cells

Pump Size Pressure 2 mm 5 mm 10 mm

F10 700 psi   

F100 700 psi   
Instrument Guide  |  79



2  |  The NGC Instrument
 Flow cell volume

Note: The volume is the total volume for the flow cell (optical and 

conductivity).

 Temperature sensor range: –40°C to 100°C

Note: Operating range for the detector and flow cell is only specified 

between 4°C to 40°C, which is the operating range of the NGC instrument.

Multi-Wavelength UV/Vis Detector

Type 2 mm 5 mm 10 mm

Dwell volume port to port (μl) 140 51 24

LEGEND

1 Conductivity monitor 2 UV/Vis detector flow cell

3 UV/Vis detector housing 
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Detectors
Detailed Attributes

 Contains one tungsten and one deuterium lamp

 Lamp operating usage: approximately 2,000 hours for the tungsten bulb as 

well as the deuterium bulb

For information about changing the UV lamps, see Replacing the Multi-

Wavelength UV/Vis Detector Lamps on page 233.

Tip:  To conserve lamp life, in Manual mode open the Multi Wave Detector 

dialog box and turn off the UV/Vis lamps when the instrument is not in use.

 Monitors up to four wavelengths in the UV/Vis range of 190–800 nm

Tip:  Use ChromLab to change the absorbance wavelength values. For 

more information, see the NGC Chromatography Systems and ChromLab 

Software User Guide.

 UV absorbance range: 0–3,000 mAU

 UV linearity: ±5%

 Three interchangeable flow cells with path lengths of 2 mm, 5 mm (default), 

and 10 mm; see Table 5 for specific information

For information about changing the flow cells, see Replacing the UV Flow Cell 

on page 214.

Note: Use the preparative 2 mm flow cell to measure high concentrations 

of protein. The path lengths of the analytical 5 mm and 10 mm flow cells 

are longer and are appropriate for measuring lower concentrations of 

protein.

Table 5. Pressure limits of UV detector flow cells

Pump Size Pressure 2 mm 5 mm 10 mm

F10 500 psi   

F100 500 psi   
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Conductivity Detector

Detailed Attributes

 Factory specified range: 0.01–999.9 mS/cm

 Validated working range: 0.01–300 mS/cm

 Accuracy: ±2%

 Flow cell volume: 6 μl

 Integrated temperature sensor range: 4–100°C
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Detectors
How They Work

UV Detectors

ChromLab recognizes the connected optic module (that is, either the 

single-wavelength UV or multi-wavelength UV/Vis module). The lamps turn on when 

the NGC instrument powers up. At the start of the method run, the system 

determines if the monitor is ready. 

The warmup time for the LED lamp in the single-wavelength detector is negligible. 

The tungsten and deuterium lamps in the multi-wavelength detector require 60–90 

min to warm up. 

Note: For most accurate data with the tungsten and deuterium lamps, allow a 

minimum of 60 min warmup time.

Conductivity Monitor

The temperature-compensated conductivity monitor calculates the conductivity of 

the sample and buffer mixture flowing through its flow cell. The stronger the salt 

concentration, the higher the conductivity signal.

Since conductivity of a solution can vary with changes in temperature, temperature 

variations of the sample are measured by the temperature sensor located in the 

conductivity flow cell. A temperature compensation factor (set in ChromLab) can be 

used to compare the conductivity of the sample in relation to the corresponding 

conductance at room temperature or a user-defined reference temperature.
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The Backpressure Regulator

A backpressure regulator can be added to the flow path to generate backpressure 

and prevent air bubbles from forming in the UV flow cells when medium pressure 

columns are used. (The NGC systems ship with a 20 psi backpressure regulator.) 

Bio-Rad recommends that the backpressure regulator be plumbed between the 

conductivity monitor and the pH monitor to avoid exceeding the 70 psi limit of the 

pH probe. 

Note: Bio-Rad does not recommend using backpressure regulators for 

columns with a precolumn pressure limit less than 72 psi (0.5 MPa).
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Detectors
pH Detector

The pH detector includes an integrated flow cell in which to insert a pH electrode. 

The pH of the solution flowing across the pH electrode is measured in real time. This 

is very useful for applications in which knowledge of the buffer pH is critical for a 

successful separation and/or the stability of the sample (for example, in antibody 

purifications). The pH can be temperature compensated.

The pH valve directs the flow to either 

 pH — flow path is inline with the pH probe, or

 Bypass — flow path bypasses the electrode

Note: In Calibrate mode, the pH electrode is offline for calibration.
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Detailed Attributes

 Flow cell volume: 90 μl (200 μl including internal valve passageways)

 Electrode maximum operating pressure: 70 psi

 pH reading range: 0–14

 Accuracy: 0.1 pH units from 2–12

 Slope: 80–120%

 Offset: ±60 mV

Note: Store the electrode in a pH electrode storage buffer or pH 7 standard 

buffer. For information about changing the pH probe, see Replacing the pH 

Probe on page 242.

Ports on the pH Detector

 

86  |  NGC Chromatography Systems and ChromLab Software



Detectors
How the pH Detector Works

The integrated pH electrode enables inline pH monitoring during a run. ChromLab 

calculates and displays temperature-compensated pH values.

You can program the position of the pH valve in ChromLab to direct the flow to the 

pH electrode, or to bypass the electrode. The section Changing the Flow Paths of 

the pH Valve on page 88 explains how to change the flow path.

The pH valve has an integrated calibration port to calibrate the probe offline without 

disconnecting the module from the system. Calibration is performed using 

calibration standards in ChromLab. For more information, see Calibrating pH on 

page 162.

Port Description

In Inlet from the conductivity monitor

Out Outlet to the fraction collector

Cal In Calibration inlet reserved for calibrating the pH valve

Cal Out Outlet to calibration waste
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Changing the Flow Paths of the pH Valve

During a manual run, you can change the flow path of the pH valve by accessing its 

dialog box in ChromLab.

To change the flow path of the pH valve

1. Touch or click the pH Valve module in the fluidic scheme to access its dialog 

box.

2. In the pH Valve dialog box, select the appropriate choice:

 pH — the flow path is inline with the pH probe

 Bypass — the flow path bypasses the pH probe
88  |  NGC Chromatography Systems and ChromLab Software



Tubing, Loops, Columns, and Fittings
Tubing, Loops, Columns, and Fittings

This section lists the accessories supported for use with the NGC systems.

Tubing

Table 6. NGC system tubing details

Description Diameter Scope of Use Maximum 
Pressure Rating

Mounted 
at Delivery

PEEK tubing, orange OD: 1/16"

ID: 0.020"

High pressure 

tubing, 

recommended for 

flow rates less 

than 40 ml/min

6,000 psi Yes

PEEK tubing, green OD: 1/16"

ID: 0.030"

High pressure 

tubing

4,000 psi Yes

Polytetrafluoroethylene 

(PTFE) tubing, 

transparent

OD: 1/8" 

ID: 0.062"

Inlet tubing 500 psi No

Tefzel tubing, 

transparent

OD: 1/16"

ID: 0.020"

Waste 4,000 psi No
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Sample Injection Loops

Columns

The NGC chromatography systems support columns for various chromatography 

techniques. ChromLab includes a library of the most common commercial columns 

in the Method Editor.

Table 7. NGC system injection loop details

Injection Loop Size Scope of Use Maximum Pressure 
Rating

100 μl Small sample sizes 4,000 psi

250 μl Small sample sizes 4,000 psi

500 μl Small sample sizes 4,000 psi

1 ml Large sample sizes 3,000 psi

2 ml Large sample sizes 3,000 psi

5 ml Large sample sizes 3,000 psi

DynaLoop 25:

25 ml

Very large sample sizes 1,000 psi

DynaLoop 90:

90 ml 

Very large sample sizes 1,000 psi
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Fittings

The NGC chromatography systems ship with 10/32 fittings for column attachment 

and 1/4-28 fittings that accommodate a large variety of commercially available 

columns.

Table 8. Supported column fittings

Column Fitting Options

GE Healthcare M6 fitting columns (for 

example XK, C, SR, old style, HiTrap, 

HiPrep, HiLoad columns)

Tefzel 1/4–28 female to M6 female 

adapter 

(catalog #750-0561);

1 kit to connect 1 column

Bio-Rad luer fitting columns (for 

example Econo-Column columns, 

Econo-Pac columns, Econo-Pac 

cartridges, and Bio-Scale Mini 

cartridges)

Female luer to M6 female adapter 

(catalog #732-0111);

1 kit to connect 1 column

Note: For more information about fittings and columns, see Bio-Rad 

bulletin 5326, Chromatography Column Connection Guide.
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LEDs and LED Screens

The modules on the NGC system are fitted with light emitting diodes (LEDs) that are 

located next to ports on the valves and on the inlet and outlet tubing connections 

for pumps and all detectors (including the UV detectors and the air sensors). 

Depending on the module, LEDs indicate

 Flow from the system pumps (green LEDs)

 Flow from the sample pump (blue LEDs)

 Point-to-Plumb flow path (pulsing green LEDs)

Several modules on the NGC system also have LED screens that display their 

current status.

When the NGC system has been inactive for two hours the LED display screens on 

the instrument turn off, the touch screen dims, and a dialog box appears on the 

touch screen informing you that the system is in standby mode. You can take the 

system out of standby mode by touching OK in the dialog box, starting the system 

pumps by initiating a manual or method run, or clicking on a module in the fluidic 

scheme that has an LED display. 
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Sensors

Air Sensors

The NGC chromatography systems can be fitted with an external air sensor module 

that can hold up to four air sensors. This module can be daisy chained to an 

extension module that can hold an additional four air sensors, providing a total of 

eight air sensors. The air sensors detect air, indicating the end of sample or buffer, 

and trigger appropriate events through ChromLab software. The air sensors are 

available in two sizes that differ in internal diameter to accommodate the two 

different tubing sizes:

 The large air sensors are used with the larger diameter 1/8" FEP tubing for 

the inlet ports of the pumps and inlet valves.

 The smaller air sensors are used with the smaller diameter 1/16" PEEK 

tubing. 

The systems detect the number of air sensors that are attached to the instrument. 

Air sensors can be set to detect air in lines filled with buffer. If air is detected in these 

lines, the system pumps stop and the run pauses. You can continue the run after 

replenishing the buffer and purging the lines.

Air sensors can also be set to detect air in lines filled with sample. If air is detected 

in these lines, the sample pump stops so that it cannot pump air onto the column. If 

an air-bubble sensing event occurs during a method run, the run continues to the 

next step.
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The air sensors are inserted into ports on the air sensor module. ChromLab detects 

the presence or absence of air sensors in the air sensor module. If you have fewer 

than four air sensors in the module, you must cover the unoccupied ports with a 

protective blank cover that Bio-Rad provides to prevent liquid from entering into the 

module’s electronic circuitry.

The air sensors can be connected to

 The inlet port on the sample pump

 The inlet port on system pump A

 The inlet port on system pump B

 Any position along the flow path of the instrument, for example

 Sample inject valve

 Buffer inlet valve
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Sensors
Air Sensor LEDs

The air sensor module is fitted with LEDs.

 Green LEDs indicate the module is connected.

 Blue LEDs indicate air in the tubing.

Prime the lines to remove air. See Priming and Purging the Systems on 

page 135 for more information.

Air Sensor Tubing Length and Bubble Size

The response of the air sensor module is highly dependent on the bubble size and 

flow rate, and requires a minimum tubing length between the sensor outlet and the 

pump inlet. Table 9 lists recommended tubing lengths for various flow rates and 

bubble sizes.

Table 9. Recommended air sensor tubing lengths

Flow Rate Bubble Size 1/8" ID FEP Tubing Length
(air sensor to pump inlet)

1 ml/min 15–25 μl ≥6"

5 ml/min 50–100 μl ≥6"

10 ml/min 200 μl ≥6"

100 ml/min 1.05–1.4 ml ≥42"
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Pressure Sensors

The NGC systems can have up to four integrated pressure sensors:

 System pressure sensor — located in the mixer module

 Precolumn and postcolumn pressure sensors — located in the column 

switching valve

These pressure sensors protect the column and media from overpressure. One 

pressure sensor measures the pressure before the column to protect the 

column hardware. The other sensor measures the pressure after the column 

and calculates the pressure difference over the media bed. If the pressure 

differential value (Delta P) exceeds the preset limit, either the run pauses or 

another action is applied.

 Sample pump pressure sensor — located in the sample pump module

Each pressure sensor has an accuracy of ±2% or 2 psi, whichever is smaller.

Temperature Sensor

The NGC systems have an integrated temperature sensor located in the 

conductivity flow cell that measures the run temperature. Sensor data is used for 

temperature compensation of conductivity and pH.
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NGC Touch Screen

The NGC system’s touch screen is the main interface between the NGC system 

computer and the ChromLab computer. From the touch screen’s pull-down menu, 

you can perform all system control functions such as starting a manual run, starting 

and monitoring a method run, or calibrating the system. 

The touch screen displays a chromatogram viewer and the fluidic scheme. The 

chromatogram shows real-time traces from the various detectors in terms of time, 

volume, or column volume. The fluidic scheme shows the real-time status of the 

various devices on the NGC system.

The touch screen can be mounted on either side of the instrument. The touch 

screen arm can tilt and rotate. It can also be removed and mounted onto the other 

side of the instrument, or placed outside a standard cold cabinet to control the 

instrument without opening the door.

For information about remounting the touch screen, see Repositioning the Touch 

Screen on page 262.
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Buffer Tray

The buffer tray on the top of the instrument can accommodate up to six 1 L bottles.

Note: Ensure that the drainhole is connected to tubing so that any potential 

leaks are properly drained.
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Product Configurations

The NGC chromatography system is available in four standard configurations. This 

section lists the modules available for each configuration. You can add or remove 

modules to an existing configuration to customize the system. The configuration at 

your site might differ slightly from any of the standard configurations.

Note: All NGC systems are available with either the 10 ml/min or the 

100 ml/min system pumps.

Table 10. NGC chromatography system configurations 

Module NGC Quest NGC Scout NGC Discover NGC Discover Pro

Sample injection valve    

Single-wavelength UV and 

conductivity monitor

(Available on the NGC 

Quest and NGC Scout 

systems only)

 

Multi-wavelength UV/Vis 

and conductivity monitor

(Available on all NGC 

systems)

  * *

System pumps A and B    

Mixer    

pH valve   

Buffer blending valve   

Column switching valve 1  

Sample pump  

Buffer inlet valves A and B  

Third expansion tier  
Instrument Guide  |  99



2  |  The NGC Instrument
Fourth expansion tier 

Sample inlet valve 1 

Outlet valve 1 

*Only the multi-wavelength UV/Vis detector is available in the NGC Discover series.

Table 10. NGC chromatography system configurations, continued

Module NGC Quest NGC Scout NGC Discover NGC Discover Pro
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3 Preparing the Instrument
The NGC instruments ship preassembled with the modules necessary to perform 

chromatographic separations. The instruments require minimal postinstallation 

setup to prepare them to run simple gradient separations. This chapter explains 

how to prepare the NGC systems for a method run.
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Module Review

The NGC systems are shipped in one of three standard configurations. Preparing 

the NGC systems differs slightly depending on the configuration.

Tip:  For information about adding, removing, or moving modules, see 

Replacing or Repositioning Modules on the NGC Instruments on page 251.

Standard NGC System Configurations

The standard NGC system configurations are depicted in the images that follow. 

Table 10 on page 99 lists specific information about each configuration.

Note: Each configuration can be converted to another by adding or removing 

modules. The configuration at your site might differ slightly from the 

configurations shown below.

NGC Quest Chromatography System

 

NGC Scout Chromatography System
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Module Review
NGC Discover Chromatography System

NGC Discover Pro Chromatography System
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NGC Systems Accessories Kit

Each NGC system ships with an accessories kit. The contents of the kit are specific 

to the system. Verify the contents against those listed in the sections that follow.

The accessories kits contain the tubing, loops, and fittings necessary to complete 

the setup of the shipped configuration. All kits include

 NGC fittings kit

 1 ml syringe

 Luer adapter

 Fittings tightener

 Touch screen and pivot arm kit

 Tool to attach touch screen

 Pump head wash inlet tubing (2)

 Pump head wash priming line

 1/4-28 union

 System pump inlet tubing (2)

 1 ml sample loop

 Waste tubing (2)

 Injection port

 20 psi backpressure regulator

 Tubing retainers, small (1, for PEEK tubing management)

 Tubing retainers, large (2, for PTFE tubing management)

 Column tubing (2) and fittings (from inject valve to column top and from 

column bottom to UV detector inlet)

 Tube #2 (conductivity flow cell to 20 psi backpressure regulator)

 Tube #4 (backpressure regulator to the NGC Fraction Collector (NGC FC) 

or BioFrac fraction collector)
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NGC Systems Accessories Kit
NGC Scout Accessories Kit

The kit for the NGC Scout system includes all the accessories in the NGC systems 

kit as well as

 Tube #2 (20 psi backpressure regulator to pH valve inlet)

 pH waste tubing

 pH calibration port inlet tubing

 Colored tubing for the buffer blending valve

NGC Discover Accessories Kit

The kit for the NGC Discover system includes all the accessories in the NGC Scout 

kit as well as

 Pump head wash inlet tubing (2) for the sample pump

 Pump head wash priming line for the sample pump

 1/4-28 union

 Sample pump inlet tubing

 System pump inlet tubing (14) for inlet valves

 Column tubing (10) and fittings (from the column switching valve Top 

positions to column top, and from column bottom to column switching 

valve Bottom positions)

NGC Discover Pro Accessories Kit

The kit for the NGC Discover Pro system includes all the accessories in the 

NGC Discover kit as well as

 Buffer inlet tubing (8) for inlet valve

 Tube #6 for the inlet valve

 Outlet valve tubing (12) for the outlet valve

 Tube #10 for the outlet valve
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Preparing the Buffer and Waste Bottles

After you plumb the instrument, prepare buffer and waste bottles.

Buffer Bottles

Place buffer bottles on the bench next to the instrument or in the buffer tray on top 

of the instrument. The tray can accommodate up to six 1 L bottles.

Waste Bottles

Place waste bottles on top of the bench or on the floor below the instrument. Ensure 

that the waste containers are large enough to hold all buffer that will flow into them. 

Empty the waste bottles regularly.

Important: Do not place waste bottles on top of the instrument.
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Connecting the Sample Injection Loops

The NGC chromatography systems support a variety of injection loop types and 

sizes, including static loops and dynamic loops. Table 7 on page 90 lists the 

supported loops. 

Note: You might have already connected a loop if you completed all of the 

steps in the section Plumbing and Priming the NGC Chromatography Systems 

in the NGC Chromatography Systems and ChromLab Software Installation 

Guide.

To connect a loop to the sample inject valve

 Connect one end of the loop to Loop E and the other end to Loop F on the 

sample inject valve.

During Load, sample enters through Loop F while air, buffer, or excess sample is 

pushed out through Loop E to waste.

During Injection, buffer enters through Loop E and pushes the sample out to the 

column through Loop F.
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Inserting Check Valves into the Sample Inject Valve

All NGC systems ship with two check valves in ports W1 and W2 on the sample 

inject valve. In addition, the sample pump ships with two extra check valves. The 

check valves apply positive backpressure to the waste ports on the sample inject 

valve and ensure against any leaks. Each check valve has an arrow to indicate the 

direction of flow.

Note: Ensure that no run is in progress and that the system is off before 

inserting the check valves.

To insert the check valves into the sample inject valve

1. In the sample pump module, locate and open the package containing two 

check valves.

2. If inserted, remove tubing from the W1 and W2 ports on the sample inject valve.

3. Insert one check valve into W1 and the other check valve into W2. Ensure that 

the arrows on each check valve point in the direction of flow (outward, away 

from the system).
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4. Connect the tubing to the check valves.

Preparing the Detectors

The NGC systems ship with the conductivity monitor and the UV detectors installed, 

calibrated, and ready for use. These modules require no preparation.

The pH module (if installed) requires you to install and calibrate the pH probe. See 

the section Replacing the pH Probe on page 242 for information about installing a 

new pH probe. 

UV Lamps

The UV detector ships with the UV lamps installed. When the instrument starts, the 

lamps turn on. 
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Changing the Mixer Barrel

The mixer module is used to blend buffers from two to four separate solutions. It is 

important to use a mixer with a barrel size that is based on the flow rate of 

separation. Bio-Rad offers several different mixer barrel sizes for different flow rates.

The F10 systems ship with the 263 μl mixer base and top assembly. When using a 

higher flow rate, the mixer volume of this base unit can be expanded by adding a 

750 μl or 2 ml barrel. The F100 systems ship with 750 μl mixer base and top 

assembly. The mixer volume can be increased at higher flow rates by inserting 

either 2ml, 5 ml, or 12 ml barrel.

Table 11 lists the recommended barrel size for different flow rates for systems 

without a buffer blending valve (gradient mode).

Table 12 on page 111 lists the recommended barrel size for different flow rates for 

systems with a buffer blending valve.

Tip:  For liquids that are difficult to mix, use a mixer barrel with a higher 

capacity.

Table 11. Recommended NGC system mixer barrel sizes — 
without buffer blending valve (gradient)

Barrel Size Flow Rate, ml/min

F10 Pump F100 Pump

263 μl

(Base and top)

0.1–1.00 n/a

750 μl

(Base and top)

1.00–9.99 1.00–4.99

2 ml 10.00–20.00 5.00–14.99

5 ml n/a 15.00–39.99

12 ml n/a 40.00–200.00
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To insert or change the mixer barrel

 To insert or change the mixer barrel, see Replacing the Mixer Components on 

page 204.

Table 12. Recommended NGC system mixer barrel sizes — 
with buffer blending valve

Barrel Size Flow Rate, ml/min

F10 Pump F100 Pump

263 μl

(Base and top)

0.1–1.99 n/a

750 μl

(Base and top)

2.00–5.99 <5.00

2 ml 6.00–11.99 5.00–11.99

5 ml 12.00–20.00 12.00–39.99

12 ml n/a 40.00–80.00
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Connecting the Air Sensor Module

The air sensors enable the ChromLab software to detect air bubbles and 

automatically trigger appropriate events. The air sensor module has a magnetic 

backing and can attach to the side of the NGC instrument. The module can hold up 

to four air sensors. 

Two types of air sensors are available that differ in their internal diameter.

 Large air sensors connect to 1/8" ID FEP tubing to detect end of buffer or 

end of sample

 Smaller air sensors connect to 1/16" ID PEEK tubing to detect end of 

buffer or end of sample, or to detect if air is present in the system

Note: The air sensor module accommodates both sizes simultaneously.

The air sensors can be inserted into the ports on the air sensor module. ChromLab 

detects the presence or absence of air sensors in the module. If you have fewer 

than four air sensors on the module, you must cover the unoccupied ports with a 

protective blank cover that is provided with the module to prevent liquid from 

entering into the module's electronic circuitry.

Caution: All air sensors connected to the air sensor module must be filled with 

liquid and devoid of air. A connected air sensor that is not plumbed and primed 

can trigger an air-bubble sensing event, which causes the pumps to stop and 

the blue air sensor LEDs to turn on.
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Air Sensor Tubing Length and Bubble Size

The response of the air sensor module is highly dependent on the bubble size and 

flow rate, and requires a minimum tubing length between the sensor outlet and the 

pump inlet. Table 13 lists recommended tubing lengths for various flow rates and 

bubble sizes.

Table 13. Recommended air sensor tubing lengths

Flow Rate Bubble Size 1/8" ID FEP Tubing Length
(air sensor to pump inlet)

1 ml/min 15–25 μl ≥6"

5 ml/min 50–100 μl ≥6"

10 ml/min 200 μl ≥6"

100 ml/min 1.05–1.4 ml ≥42"
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Attaching and Activating Air Sensors

This section explains how to attach the air sensor module and the air sensors. It 

also explains how to activate the air sensors after they are attached.

Note: Bio-Rad recommends that all buffers be filtered and degassed prior to 

use.

To attach the air sensor module and air sensors

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC system.

2. Attach the air sensor module to the side of the instrument.

3. Insert the connector cable on the air sensor module into one of the peripheral 

connector ports on the side of the NGC instrument.

4. To connect an air sensor to the sample pump:

a. Connect tubing from the sample container to the port on top of an air 

sensor.

b. Connect the tubing from the port on the bottom of the air sensor to the 

inlet port of the sample pump.
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5. To connect an air sensor to the system pumps:

a. Connect tubing from the buffer bottle or from the outlet port on the buffer 

inlet valve to the port on top of an air sensor.

b. Connect tubing from the port on the bottom of the air sensor to the inlet 

port on either system pump.

6. To connect air sensors to the buffer blending valve:

a. Connect tubing from each buffer bottle to the port on the top of each air 

sensor that will be used.

b. Connect tubing from the port on the bottom of each air sensor to the inlet 

ports on the buffer blending valve.

Alternatively you can attach tubing from outlets A and B of the buffer blending 

valve to the top of the air sensors. Connect the ports from the bottom of each 

air sensor to the inlets of system pumps A and B, respectively. In this setup, 

although air will be prevented from entering the system pumps and the system 

will react to end of buffer, the system will not distinguish which port to 

replenish.

To activate the air sensors

1. Restart the NGC system.

The green LEDs on the air sensor module should turn on.

2. Select File > System Settings to open the System Settings dialog box.

3. Select the Air Sensors tab.

By default, only the air sensors that the system detects are enabled. The other 

sensors are disabled.

4. For each air sensor that you want activate, select its checkbox and from its 

dropdown list choose either Sample to detect end of sample or Buffer to detect 

end of buffer.

5. Click OK.
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Connecting External Devices to the NGC Instrument

Tip:  If you do not plan to connect the C-96 autosampler or other external 

devices to the NGC instrument you can skip this section.

This section explains how to connect the signal import module (SIM) to the NGC 

instrument, and how to connect external devices to the SIM.

 For information about connecting the C-96 autosampler to the SIM, see 

Appendix D, Connecting the C-96 Autosampler to NGC Systems on 

page 313.

 For information about connecting the SIM to an NGC instrument, see 

Connecting the SIM to the NGC Instrument on page 117.

 For information about connecting an external device to the SIM, see 

Connecting External Devices to the SIM on page 119. Next, see the 

chapter System Controls in the NGC Chromatography Systems and 

ChromLab Software User Guide to enable the external device.

 For information about installing and setting up an external device, see its 

installation documentation.

Controlling Programmed Functions via 
Transistor-to-Transistor Logic

You can control a function of an external device or receive function information from 

a device via the SIM. Using the SIM’s transistor-to-transistor logic (TTL), the NGC 

instrument can mark when a function occurred on an external device through the 

SIM’s DIGITAL IN port, or send commands to an external device through its DIGITAL 

OUT port.

For example, you can connect a C-96 autosampler to the SIM enabling NGC 

systems to provide automated, accurate, and reproducible sample injections. 

Connecting the autosampler to the SIM’s DIGITAL OUT and DIGITAL IN ports 

enables the NGC instrument to inform the autosampler when to begin its injection 

cycle and to mark when the autosampler injects a sample. 
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Importing Analog Signals to the NGC Instrument

You can import analog (voltage) signal from up to two external devices and convert 

it to digital NGC data via the SIM. The SIM imports and converts the signal to the 

appropriate trace units through its SIM 1 and SIM 2 ports. When data import is 

enabled (through System Settings in ChromLab), the details appear in the 

chromatogram’s legend, the trace appears on the chromatogram, and the data can 

be analyzed in the Evaluation window.

Exporting Digital Data from the NGC Instrument

You can convert digital NGC data to analog voltage via the SIM and output the 

voltage to an external recording device, such as a light scattering detector. The SIM 

converts and outputs NGC trace information as voltage through its digital-to-analog 

converter (DAC) ports. By connecting a trigger wire to terminal 2 on the DIGITAL 

OUT connector, the SIM can send a signal to the device triggering it to start 

measuring data. Voltage from port 2 changes from High (5 V) to Low (0 V) when 

sample injection starts and returns to High when the injection stops.

When analog output is enabled (through System Settings in ChromLab), the external 

device can receive the converted trace information.

Connecting the SIM to the NGC Instrument

To connect the SIM to an NGC instrument

1. Locate the peripheral cable that ships with the SIM.

2. Insert one end of the peripheral cable into the peripheral port on the SIM.
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3. Insert the other end of the cable into one of the peripheral connector ports on 

the side of the NGC instrument.
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Connecting External Devices to the SIM

WARNING!  These procedures require you to work with exposed wires. Ensure 

that your systems are powered off and unplugged before performing this task.

This section explains how to connect different external devices to the SIM. Before 

connecting the device, locate the connector ports that you will use on the back of 

the SIM. Notice that the terminals differ for different devices:

 To import analog signals to the NGC instrument, connect the external 

device to either the SIM 1 or SIM 2 ports. See the section To connect an 

external device to the SIM 1 and SIM 2 ports that follows.

 To export digital signals from the NGC instrument, connect the external 

device to the DAC A port. Optionally, to trigger the external device to start 

measuring data from the NGC instrument, connect a trigger wire to the 

DIGITAL OUT port. See the section To connect an external device to the 

DAC A and DIGITAL OUT ports on page 124.

Tip:  The SIM ships with its connectors inserted into their ports.

To connect an external device to the SIM 1 and SIM 2 ports

1. On the back of the SIM, firmly grasp the green SIM 1 or SIM 2 connector and 

pull it straight out of its port.

2. Locate the green flathead screwdriver included in the SIM’s accessory kit.
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3. Loosen all three screws on the top of the connector.

Tip:  These screws adjust the terminals that hold the wires in place. The 

screws do not dislodge from the connector.

4. Locate the analog output cable that ships with your detector.

5. If connectors are attached to both ends of the cable, remove the connector that 

does not insert into your detector.

Tip:  Alternatively, contact the manufacturer for a suitable cable.

6. If necessary, strip the plastic wire coating off the wires so that they are 

exposed.

7. Obtain a small piece of 20–24 AWG negative wire.

8. Bend the wire into a U shape and strip the plastic coating off both ends to 

create a jumper wire.
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9. On the analog output cable, determine the positive and negative wires.

10. Insert the positive wire into the left terminal on the connector and tighten the 

screw.

Note: Take care not to overtighten or fray the wire.
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11. Insert the negative wire and one end of the jumper wire into the middle terminal 

on the connector and tighten the screw.

12. Insert the other end of the jumper wire into the right, or ground, terminal on the 

connector and tighten the screw.
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13. Insert the connector into the SIM 1 or SIM 2 port on the back of the SIM.

14. Refer to the chapter System Controls in the NGC Chromatography Systems 

and ChromLab Software User Guide for information about how to enable signal 

import from the device.
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To connect an external device to the DAC A and DIGITAL OUT ports

1. On the back of the SIM, firmly grasp the DAC A connector and pull it straight 

out of its port.

Note: ChromLab supports solely the DAC A port. When connecting an 

analog instrument to the SIM, use the DAC port on the right (DAC A).

2. (Optional) If you want the NGC instrument to trigger the device to start 

measuring data, also remove the DIGITAL OUT connector and perform the 

steps that follow.

3. Locate the green flathead screwdriver included in the SIM’s accessory kit.

4. Loosen the positive and ground screws on the DAC A connector and terminal 2 

screw on the DIGITAL OUT connector.

Note: Terminal 1 on the DIGITAL OUT connector is reserved for the 

autosampler. Do not insert the trigger wire into terminal 1. Terminal 2 is the 

second screw from the right.

5. Locate the output cable that ships with your DAC device.

6. If connectors are attached to both ends of the cable, remove the connector that 

does not insert into your device.

Tip:  Alternatively, contact the manufacturer for a suitable cable.

7. If necessary, strip the plastic wire coating off the wires so that they are 

exposed.

8. Determine the positive, ground, and trigger wires on the cable.
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9. Insert the positive and ground wires into the appropriate terminals on the 

DAC A connector and tighten the screws, taking care not to fray the wires.

10. Insert the trigger wire into terminal 2 on the DIGITAL OUT connector and tighten 

the screw, taking care not to fray the wire.

11. Insert the connectors into their ports on the back of the SIM.

12. Refer to the chapter System Controls in the NGC Chromatography Systems 

and ChromLab Software User Guide for information about how to enable signal 

output to the device.

Trigger wire
Positive 

wire

Ground 

wire
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Connecting Fraction Collectors to the NGC Instrument

You can connect up to two NGC Fraction Collectors (NGC FC) or one BioFrac and 

one NGC FC to the NGC instrument. This section explains how to connect the 

supported fraction collectors to the NGC instrument.

Connecting the NGC Fraction Collector

Tip:  For information about setting up and using the NGC FC, see the NGC 

Fraction Collector Instrument Guide.

The NGC FC requires a USB cable to connect to the NGC instrument. Bio-Rad 

supplies this cable with the NGC FC. ChromLab detects the fraction collector by 

way of the USB cable.

To connect the NGC FC to the NGC instrument

1. Ensure that the NGC instrument and the NGC FC are powered off.

2. Locate the USB Type B port on the back of the NGC FC.

3. Locate USB Type B cable that ships with the NGC FC.

Important: You must use the USB cable that ships with the NGC FC to 

connect it to the NGC system.

4. Insert the square (male) end of the USB Type B cable into the USB Type B port 

on the back of the NGC FC.
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5. Insert the other (port) end of the cable into one of the USB ports on the NGC 

instrument.

6. Power on the instruments:

a. Power on the NGC FC first.

b. Press the soft power switch on the NGC instrument to power it on.

The gantry and dispense head move to the home position when the NGC 

instrument is powered on and detects the NGC FC.
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Connecting the BioFrac Fraction Collector

Tip:  For information about setting up and using the fraction collector, see the 

BioFrac Fraction Collector User Guide.

The BioFrac fraction collector requires the communication adapter and its cable to 

connect to the NGC instrument. ChromLab detects the fraction collector by way of 

the communication adapter. 

To connect the BioFrac fraction collector to the NGC instrument

1. Ensure that the NGC instrument and the fraction collector are powered off.

2. Locate the connector port marked INSTRUMENT BUS on the back of the 

BioFrac fraction collector.

3. Insert system cable 17 that ships with the fraction collector into an 

INSTRUMENT BUS connector port. 

4. Insert the other end of the cable into the INSTR. BUS connector on the back of 

the communication adapter.
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Tip:  The RX and DX diodes are communication indicators. You see the 

lights flash as data transfer between the fraction collector and the NGC 

instrument. The COMM port is not used to connect to the fraction 

collector.

5. Locate the peripheral cable that ships with the communication adapter.

6. Insert one end of the peripheral cable into the peripheral port on the 

communication adapter.

7. Insert the other end of the cable into one of the peripheral ports on the NGC 

instrument.
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8. Power on the instruments:

a. Power on the BioFrac fraction collector first.

b. Press the soft power switch on the NGC instrument to power it on.
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Starting the NGC Instrument

Caution: The NGC system runs under high pressure. Follow the safety 

precautions established for the laboratory at all times.

To start the NGC instrument

 Locate and press the soft power switch on the side of the NGC instrument.

Tip:  Starting the system and the internal software might take some time.
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Connecting the NGC System to ChromLab Software

Note: For information about installing ChromLab, see the NGC 

Chromatography Systems and ChromLab Software Installation Guide.

To connect the NGC system to ChromLab software

 Do one of the following on the computer running ChromLab (known as the 

ChromLab computer in this document):

 Double-click the ChromLab desktop icon.

 Select ChromLab on the Start menu.

The system software connects to the last successfully used NGC instrument.

Tip:  To connect to another instrument, click File > Connect to system. In 

the System Connection dialog box, select the instrument you need and 

click Connect.
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Verifying Plumbing with the Point-to-Plumb Feature

The Point-to-Plumb feature in ChromLab helps you when making changes to the 

plumbing or to verify that the instrument is plumbed correctly for the fluidic scheme 

that you want to use. 

You can access the Point-to-Plumb feature on the touch screen menu or through 

the Tools menu on the System Control tab in ChromLab. 

When you select Point-to-Plumb, the current fluidic scheme appears in 

Point-to-Plumb mode and all LEDs on the instrument turn off. 

The proper plumbing path is indicated by the color gray. Path elements that are not 

plumbed appear in a paler shade of gray and do not change color when selected. 
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To verify the plumbing path 

1. With both the Point-to-Plumb screen and the front of the instrument in view, 

touch or click a segment along the gray path.

The segment you selected turns green.

At the same time, the LEDs on the front of the instrument indicate the selected 

plumbing path.

2. Verify that the tubing is connected at the ports indicated by the LEDs, to 

replicate the Point-to-Plumb display. If it is not correct, replumb it.

3. Continue to select segments along the plumbing path and verify that they are 

plumbed according to the LEDs on the instrument.

4. When you are finished verifying the plumbing path, click Exit Point-to-Plumb.

All the LEDs return to status mode (green) and indicate the position of each 

valve. 
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Priming and Purging the Systems

This section explains how to prime your system before running the pumps, and 

how to purge your system of air bubbles or rapidly exchanging buffer 

solutions. 

Note: This section assumes that you primed the pump head wash system 

when you installed the system. See Plumbing All NGC Systems on page 289 for 

more information.

Priming and purging tasks are specific to the NGC system configuration. Table 14 

lists the tasks that are associated with each system configuration. The tasks are 

explained in detail in the sections that follow. 

Table 14. Priming and purging tasks for each NGC system configuration

NGC Quest NGC Scout NGC Discover

Prime and purge the 

inlet port on system 

pump A.

Prime and purge Q1–Q4 

on the buffer blending 

valve.

Tip:  The inlet ports 

on system pumps A 

and B are primed 

and purged when 

the buffer blending 

valve is primed. 

Prime and purge Q1–Q4 on 

the buffer blending valve.

Tip:  The inlet ports on 

system pumps A and B 

are primed and purged 

when the buffer 

blending valve is 

primed. 

Prime and purge the 

inlet port on system 

pump B.

Prime and purge the buffer 

inlet valves A and B.

Prime and purge the sample 

pump.
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Priming and Purging the NGC Quest System

Caution: Before priming or purging the system, ensure that any attached 

columns are offline. The priming process occurs at a high flow rate and can 

significantly harm or destroy attached columns.

Priming and purging the NGC Quest system requires access to ChromLab. You can 

perform the steps on the ChromLab computer or on the NGC touch screen.

Important: The instrument’s buffer lines cannot be primed when the system is 

under pressure. Before opening the priming port, turn the inject valve to Waste 

to release the system pressure.

To prime the system pumps

1. Immerse the inlet tubing for both system pumps A and B in a container of 

buffer or HPLC grade (filtered, degassed) or other high-quality water.

2. Insert a 30 ml syringe into the priming port on system pump A.

3. Turn the priming port valve counter-clockwise one full turn to open the seal.

4. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml) and all tubing is filled with 

liquid.

5. Turn the priming port valve clockwise to close the port.
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6. Remove the syringe from the priming port and discard the liquid into waste.

7. Repeat steps 2–6 for system pump B.

To purge the system pumps

1. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

2. Set the fluidic scheme to either NGC Quest or NGC Quest Plus.

3. In the fluidic scheme, touch or click the Sample Inject Valve module to open its 

dialog box.

4. Set the sample inject valve to System Pump Waste.
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5.  In the fluidic scheme, touch or click the System Pump module to open its 

dialog box.

6. In the System Pump dialog box:

a. Set Flow Rate to 10 ml/min.

b. (Optional) Set Duration to at least one min.

c. Click Start.
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Priming and Purging the NGC Scout System

Priming the NGC Scout system is a manual procedure and involves priming the 

buffer blending valve starting from the Q4 port to Q1. You can purge one line at a 

time, or all lines sequentially. These procedures require access to ChromLab.

Tip:  You can perform the steps on the NGC touch screen.

Priming the NGC Scout System

Note: This section assumes that you have not introduced buffer into the lines. 

If you have buffer in the lines and are purging the lines of small air bubbles, 

proceed to Purging the NGC Scout System on page 141.

To prime the buffer blending valve

1. Immerse the inlet tubing for ports Q1–Q4 in their respective buffer containers. 

(See To plumb the buffer blending valve on page 300 for more information.)

2. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

3. Set the fluidic scheme to either NGC Scout or NGC Scout Plus.

4. In the fluidic scheme, touch or click the System Pump module to open its 

dialog box.
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5. In the System Pump dialog box, select Priming on the Mode dropdown list.

Note: When in Priming mode, the sample inject valve switches the system 

pump flow to waste (W2). After the process is completed, the sample inject 

valve switches the system pump to manually load the column through the 

loop.

By default, all ports are closed. The Closed radio button is selected.

6. Select Q4 as the port to open and prime.

7. Insert a 30 ml syringe into the priming port on system pump A.

8. Turn the priming port valve counter-clockwise one full turn to open the seal.

9. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml) and the tubing is filled with 

liquid. 

10. Turn the priming port valve clockwise to close the port.

11. Remove the syringe from the priming port and discard the liquid into waste.

12. Repeat steps 7–11 for ports Q3–Q1.

13. To prime system pump B, select port Q3 perform steps 7–11.
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Purging the NGC Scout System

To purge the buffer blending valve 

1. Open the System Pump dialog box and select Priming in the Mode dropdown 

list.

 To purge an individual line of air bubbles, proceed to step 2 that follows.

 To purge all lines of air bubbles sequentially, proceed to step 3 on 

page 142.

2. To purge an individual line of air bubbles and fill it with buffer:

a. Select a port to open.

b. (Optional) Change the default flow rate.

The default flow rate is set to 20 ml/min. 

c. Click Start.

d. Repeat steps 2a–c for any other port to purge.
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3. To purge all lines of air bubbles and fill them with buffer:

a. Click All.

b. (Optional) Change the default flow rate.

The default flow rate is set to 20 ml/min.

c. Click Start.

The system pumps and the buffer blending valve start operating at the 

specified flow rate, exchanging the solution in the inlet lines and expelling any 

trapped bubbles, cycling sequentially through the ports Q1 to Q4. After the 

specified duration, the pumps stop momentarily while the blending valve 

switches to port Q3 in order to flush the lines with water before closing the 

valve. No change is allowed during this process for the specified duration.

Note: You can stop the cycle before it completes by clicking Stop. Before 

stopping the purge cycle, ensure that all buffer lines are filled with the 

appropriate buffers starting a run.
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Priming and Purging the NGC Discover System

Priming the NGC Discover system is a manual procedure and involves priming the 

buffer blending valve starting from the Q4 port to Q1 then the buffer inlet valve 

starting from buffer inlet A1. Purging the NGC Discover system is an automated 

procedure and involves removing air from one or all buffer lines as well as the buffer 

inlet valves and the system and sample pumps. Both procedures require access to 

ChromLab.

Tip:  You can perform the steps on the NGC touch screen.

On the NGC Discover system you prime and purge the following modules:

 Buffer blending valve module

 Buffer inlet valve modules

 Sample pump module 

 Sample inlet module (NGC Discover Pro series)

Priming the NGC Discover System

Note: This section assumes that you have not introduced buffer into the lines. 

If you have buffer in the lines and are purging the lines of small air bubbles, 

proceed to Purging the NGC Discover System on page 150.

Important: The instrument’s buffer lines cannot be primed when the system is 

under pressure. If your system does not have a buffer blending valve, turn the 

inject valve to Waste to release the system pressure before opening the priming 

port.

To prime the buffer blending valve

1. Immerse the inlet tubing for ports Q1–Q4 in their respective buffer containers. 

(See Plumbing the NGC Discover System on page 302 for more information.)

2. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

3. Set the fluidic scheme to NGC Discover.
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4. In the fluidic scheme, touch or click the System Pump module to open its 

dialog box.

5. In the System Pump dialog box, select Priming on the Mode dropdown list.

Note: When in Priming mode, the sample inject valve switches the system 

pump flow to waste (W2). After the process is completed, the sample inject 

valve switches the system pump to manually load the column through the 

loop.

6. Select Q4 as the port to open and prime.
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7. Insert a 30 ml syringe into the priming port on system pump A.

8. Turn the priming port valve counter-clockwise one full turn to open the seal.

9. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml) and all tubing is filled with 

liquid. 

10. Turn the priming port valve clockwise to close the port.

11. Remove the syringe from the priming port and discard the liquid into waste.

12. Repeat steps 7–11 for ports Q3–Q1.

13. To prime system pump B, select port Q3 and perform steps 7–11.
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To prime the buffer inlet valves

1. Immerse the tubing for the inlet valves in their respective buffer containers.

2. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

3. In the System Pump dialog box, select the first inlet port to prime, for example 

Buffer A 1.

 

4. Insert a 30 ml syringe into the priming port on system pump A.

5. Turn the priming port valve counter-clockwise one full turn to open the seal.

6. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml) and all the tubing is filled 

with liquid. 

7. Turn the priming port valve clockwise to close the port.
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8. Remove the syringe from the priming port and discard the liquid into waste.

9. Repeat steps 4–8 for the remaining buffer inlet ports.

10. To prime system pump B, select buffer B1 and perform steps 3–9 on system 

pump B.

To prime the sample pump

1. Immerse the inlet tubing for the sample pump in the appropriate container.

2. Insert a 30 ml syringe into the priming port.

3. Turn the priming port valve counter-clockwise one full turn to open the seal.

4. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml) and all tubing is filled with 

liquid.

5. Turn the priming port valve clockwise to close the port.

6. Remove the syringe from the priming port and discard the liquid into waste.
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To prime the sample inlet valve (if available)

1. Immerse the tubing for the inlet valve in the appropriate container.

2. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

3. In the fluidic scheme, touch or click the Sample Pump module with the sample 

inlet valve to open its dialog box. 

4. In the Sample Pump dialog box, select the first sample inlet port to prime.
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5. Insert a 30 ml syringe into the sample pump’s priming port.

6. Slowly withdraw the plunger to withdraw liquid from the port until air no 

longer enters the syringe (approximately 10 ml). 

7. Remove the syringe from the priming port and discard the liquid into waste.

8. Repeat steps 4–7 for the remaining sample inlet ports.
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Purging the NGC Discover System

To purge the buffer blending valve

1. Open the System Pump dialog box and select Priming on the Mode dropdown 

list.

Note: When in Priming mode, the sample inject valve switches the system 

pump flow to waste (W2). After the process is completed, the sample inject 

valve switches the system pump to manually load the column through the 

loop.

 To purge an individual line of air bubbles, proceed to step 2 on page 151.

 To purge all lines of air bubbles sequentially, proceed to step 3 on 

page 151.
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2. To purge an individual line of air bubbles and fill it with buffer:

a. Select the port to open.

b. (Optional) Change the default flow rate.

The default flow rate is set to 20 ml/min.

c. Click Start.

d. Repeat steps 2a–c for any other port to purge.

3. To purge all lines of air bubbles and fill them with buffer:

a. Select All.

b. (Optional) Change the default flow rate.

The default flow rate is set to 20 ml/min.

c. Click Start.

The system pumps and the buffer blending valve start operating at the 

specified flow rate, exchanging the solution in the inlet lines and expelling any 

trapped bubbles, cycling sequentially through the ports Q1 to Q4. After the 

specified duration, the pumps stop momentarily while the blending valve 

switches to port Q3 in order to flush the lines with water before closing the 

valve. No change is allowed during this process for the specified duration.

Note: You can stop the cycle before it completes by clicking Stop. In this 

case, ensure that all buffer lines are filled with the appropriate buffers 

before continuing.
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To purge the buffer inlet valves

1. Open the System Pump dialog box and select Priming on the Mode dropdown 

list.

Note: When in Priming mode, the sample inject valve switches the system 

pump flow to waste (W2). After the process is completed, the sample inject 

valve switches the system pump to manually load the column through the 

loop.

2. Select the first buffer port to purge, for example Buffer A 1.

3. (Optional) Change the default flow rate.

The default flow rate is set to 10 ml/min.

4. Click Start.

5. Repeat steps 2–4 for the remaining buffer inlet ports.
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To purge the sample pump

1. In the fluidic scheme, touch or click the Sample Pump module to open its 

dialog box.

2. In the Sample Pump dialog box, set Flow Rate to 10 ml/min.
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3. Click Change Position to set the sample inject valve to Sample Pump Waste 

and close the dialog box.

4. (Optional) When an air sensor is present, in the Sample Pump dialog box, select 

Enable Air Sensor to use end-of-sample detection to stop the pump.

5. Click Start.

To purge the sample inlet valve (if available)

1. In the fluidic scheme, touch or click the Sample Pump module with the sample 

inlet valve to open its dialog box. 
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2. In the Sample Pump dialog box, do one of the following:

 If only one sample inlet valve is present, select S1 Port 8 as the port to 

purge.

 If two sample inlet valves are present, click Valve 2 and select S2 Port 8 as 

the port to purge.

3. Set Flow Rate to 10 ml/min.

4. Click Change Position to set the sample inject valve to Sample Pump Waste 

and close the dialog box.

5. (Optional) When an air sensor is present, in the Sample Pump dialog box, select 

Enable Air Sensor to use end-of-sample detection to stop the pump.

6. Click Start.

7. Monitor the pump pressure and outlet flow to ensure that no air is in the lines 

and that the fluid is flowing properly.
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Preparing the System and Sample Pump Piston Washing 
Systems

Note: Place the washing systems reservoir for the system and sample pumps 

at the same height or above the level of the pump heads to avoid siphoning of 

the solution back to the reservoir.

If the washing system is not thoroughly primed and devoid of air, recirculation might 

not occur at flow rates below

 0.3 ml/min for the F10 pump piston washing system

 3.0 ml/min for the F100 pump piston washing system

If routinely operating at low flow rates, reprime the washing system to ensure 

recirculation and efficient piston washing. You can reprime the system pumps by 

operating the pump for a brief period at a flow rate of

 1.0 ml/min or greater for the F10 pump piston washing system

 10 ml/min or greater for the F100 pump piston washing system

Tip:  You can also reprime the system manually as explained in the section 

Priming and Purging the Systems on page 135.
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Preparing the Columns

Before a method can be run, the column must be connected to the instrument. 

Plumb the column between the sample inject valve and UV detector or the column 

switching valve (if installed). You can mount columns using the column clips 

included in the accessories kit. Small columns can be mounted either on the front or 

the side of the instrument using the cartridge holders, which are capable of holding 

1–10 ml cartridges. Large columns should be mounted either on a separate rack or 

on the side of the instrument using the larger column holders, which are capable of 

holding columns up to 35 mm in size.

Caution: Prime the system before connecting a column to the NGC instrument 

to avoid exposing the column to air trapped in the lines. Ensure the columns are 

offline during the priming process. Read the technical information included with 

the columns to ensure that the system does not exceed the maximum 

allowable pressure.
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Connecting Column Clamps to the NGC Instrument

The NGC instrument has indented metallic strips on both the right and left sides on 

which to mount column clamps, air sensors, and the fittings tightener. The column 

clamps can be placed at any position on the strips. The column clamps are 

adjustable and can accept a variety of column sizes up to 35 mm in diameter.

Tip:  For long columns use two column clamps to keep the columns from 

tipping.

Caution: Do not overtighten the clamps. Glass columns can shatter if the 

clamps are overtightened.
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Connecting Tubing to the Columns

Note: Ensure that the system has been purged of air and that the tubing is 

filled with buffer before connecting the columns. Review and perform the tasks 

in Priming and Purging the Systems beginning on page 135. 

To connect tubing to the columns

1. Connect tubing from one of the following modules to the top of the column:

 Sample inject valve column port

 Column switching valve inlet port (1–5)

2. Remove the plug from the bottom of the column.

3. Connect the tubing from one of the following modules to the bottom of the 

column:

 UV monitor

 Column switching valve outlet port (1–5)
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Washing the Columns

Cleaning a column requires access to ChromLab. You can perform this task from 

the ChromLab computer or the NGC touch screen. This procedure explains how to 

manually wash columns through the System Control tab in ChromLab. Alternatively, 

you can wash columns in the following phases in the Method Editor: System 

Preparation, Column Activation, or Column Wash. See the NGC Chromatography 

Systems and ChromLab Software User Guide for more information about these 

phases.

Caution: If you wash the column in the reverse flow direction, set the flow rate 

to half the column’s recommended flow rate (keep the pressure below the 

recommended maximum). 

Important: Verify compatibility before using a wash solvent. Many wash 

solvents are a higher viscosity than the typical eluting solvents. You might need 

to reduce the flow rate to avoid exceeding the maximum allowable pressure. 

Refer to the column specification sheet for recommended cleaning solutions, 

flow rates, column volume rates, and storage solutions.

To wash a column

1. Immerse the system pump inlet line in the buffer solution.

2. In the fluidic scheme, touch or click the System Pump module to open its 

dialog box.

3. In the System Pump dialog box:

a. For the NGC Scout and NGC Discover systems, on the Mode dropdown 

list select one of the following:

 Gradient via Inlet Valves

 Gradient via Blending Valve (High Flow)

b. Set Flow Rate to 1 ml/min (or manufacturer’s specification).

c. Set the gradient to Isocratic.

d. Set Duration to 3–5 min (or manufacturer’s specification).
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e. Click Start.

4. Run the buffer solution through the column for 3–5 column volume (CV) (or 

manufacturer’s specification).

5. Run degassed deionized water through the column for 3–5 CV (or 

manufacturer’s specification).

6. Run the manufacturer’s recommended reagent through the column for 3–5 CV 

(or manufacturer’s specification).

7. Run degassed deionized water through the column for 10 CV (or 

manufacturer’s specification).

8. (Optional) Store the column in 20% ethanol (or manufacturer’s specification).
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Calibrating the NGC Instrument 

The NGC systems include integrated pressure and temperature sensors. The 

pressure sensors monitor the system pressure to protect the column and media 

from overpressure. The temperature sensor in the conductivity monitor enables the 

system to provide real-time temperature compensation for conductivity and pH 

measurements. The measured temperature appears as a trace on the 

chromatogram.

All sensors and detectors on the NGC systems ship precalibrated to ensure 

accurate monitoring. ChromLab enables you to recalibrate the pump flow rate and 

the conductivity and the pH monitors, zero the pressure sensors, and reset them to 

their factory settings. 

Note: You cannot run a method while calibrating the instrument.

Tip:  This section provides general procedures for calibrating the modules. For 

more information about using ChromLab to calibrate the modules, see the NGC 

Chromatography Systems and ChromLab Software User Guide.

Calibrating pH

Use two pH calibration buffers with a difference of at least one pH unit. Allow the 

buffers to reach the operating temperature before use.

To calibrate pH

1. Do one of the following:

 On the ChromLab computer, select the System Control tab, click 

Tools > Calibrate, and select pH on the dropdown list.

 On the NGC touch screen, select Calibrate on the ChromLab dropdown 

menu and then select pH on the dropdown list.

2. Follow the steps in the pH Calibration dialog box.

3. Verify that Status (at the bottom of the dialog box) is Calibrated.
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Calibrating the Pump Flow Rate

Prime and purge the system pumps with water before starting the calibration 

procedure. Calibrate the flow rate with water. 

Note: Ensure that the column is offline before performing this task.

To calibrate the pump flow rate

1. Do one of the following:

 On the ChromLab computer, select the System Control tab, click 

Tools > Calibrate, and select Pump Flow Rate on the dropdown list.

 On the NGC touch screen, select Calibrate on the ChromLab dropdown 

menu and then select Pump Flow Rate on the dropdown list.

2. Follow the steps in the Pump Flow Rate Calibration dialog box.

3. Verify that Status (at the bottom of the dialog box) is Calibrated.

Calibrating Pressure Sensor Zero Point

Use this procedure to zero the pressure on the following modules:

 Sample pump

 System pump

 Column switching valve

To zero the pressure

1. Ensure the modules are not plumbed and they are at ambient pressure.

2. Do one of the following:

 On the ChromLab computer, select the System Control tab, click 

Tools > Calibrate, and select the pump or valve on the dropdown list.

 On the NGC touch screen, select Calibrate on the ChromLab dropdown 

menu and then select the pump or valve on the dropdown list.
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3. Follow the steps in the Calibration dialog box.

4. Verify that Status (at the bottom of the dialog box) is Calibrated.

Calibrating the Conductivity Monitor

Flow conductivity standard from any commercial supplier through the conductivity 

flow cell until a stable reading is obtained.

To calibrate the conductivity monitor

1. Do one of the following:

 On the ChromLab computer, select the System Control tab, click 

Tools > Calibrate, and select Conductivity Monitor on the dropdown list.

 On the NGC touch screen, select Calibrate on the ChromLab dropdown 

menu and then select Conductivity Monitor on the dropdown list.

2. Follow the steps in the Conductivity Monitor dialog box.

3. Verify that Status (at the bottom of the dialog box) is Calibrated.
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Regular cleaning and maintenance ensures that your NGC system continues to 

perform optimally. This appendix provides a maintenance schedule and explains 

proper care for the NGC instrument.

WARNING!  Disconnect power to the NGC system before servicing any 

module. Do not attempt to service any component on the NGC instrument 

unless noted in this manual. Contact Bio-Rad for service requests.
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Cleaning the Outer Surfaces of the NGC Instrument

During normal operation, spills and splashes can cause residue to form on the 

module faceplates and fluidic lines. 

 Use a damp cloth to clean the faceplates. Avoid using excessive moisture around 

the power switch and connector outlets located on the lower right and back sides of 

the unit.

 Clean the buffer tray. Rinse away any residue with water and empty through the 

drainage hole.

Cleaning the NGC Fluidics System

Tip:  You can use the System CIP/Storage phase in ChromLab software to 

clean the system’s fluidic path. See the NGC Chromatography Systems and 

ChromLab Software User Guide for information about performing CIP (clean in 

place).

 Wash all fluidic lines with filtered 1 N NaOH solution.

 Rinse the fluidic lines with filtered deionized water to remove all traces of NaOH.

 Immerse all inlet lines in fresh water and rinse their external surface to remove 

any trace of NaOH. 
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Storing the NGC Instrument

Tip:  You can use the System CIP–Storage phase in ChromLab to store the 

fluidic lines and system components. See the NGC Chromatography Systems 

and ChromLab Software User Guide for more information.

To store the NGC instrument overnight, note the following precautions:

 Thoroughly flush all valves with water to remove buffer salts.

 If the NGC instrument is in a cold environment, keep it powered on to 

prevent condensation. If it is at room temperature, the instrument can be 

kept on or turned off.

If the ChromLab computer is located at room temperature, both the computer 

and its monitor can be turned off to conserve energy (as long as no run is in 

progress).

To store the NGC instrument long-term, note the following precautions:

 Follow the manufacturer’s instructions to clean and store the columns.

 If you use the column switching valve, ensure that the valve position is set 

to Bypass before you perform System CIP–Storage in ChromLab.

 If you do not use the column switching valve, detach the column from the 

instrument.

 Run deionized water through the entire system to wash and remove 

contaminants from all wetted parts.

 To inhibit bacterial growth, fill the system’s fluid path with either 20% 

ethanol or isopropyl alcohol (IPA) when storing it over prolonged periods. 
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Recommended Maintenance Schedule

Table 15 lists recommended maintenance tasks for the NGC instrument.

Table 15. NGC instrument maintenance schedule 

Interval Component Action

Daily

pH monitor Calibrate the pH monitor. Start ChromLab 

software and select Tools > Calibrate and 

choose pH from the dropdown list.

Store the pH electrode in storage solution 

when not in use. See Table 16 for 

recommended storage solutions.

Tip:  See Storing the pH Electrode on 

page 241 for information about storing 

the electrode.

Fluidic system Inspect the system for leaks.

Flush with water at the end of the day to 

remove sample and buffer salts.

Columns Perform CIP and store in 20% ethanol.

Tip:  System CIP–Storage is a phase in 

ChromLab.

See the NGC Chromatography Systems and 

ChromLab Software User Guide. 

Waste containers Empty the containers.

Weekly

System pumps Change the pump head wash solution and 

prime the system.

Sample pump Change the pump head wash solution and 

prime the system.
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Yearly

Sample pump seals and 

check valve

Replace the seals and check valves using 

the pump head maintenance kit.

System pump seals and 

check valve

Replace the seals and check valve using the 

pump head maintenance kit.

Post-inject valve tubing Replace all tubing.

Inline filter Replace if installed.

Bottle filter Replace or clean if installed.

pH electrode Replace yearly or earlier if necessary.

Check the values for slope and offset. Start 

ChromLab software and select Tools > 

Calibrate and choose pH from the dropdown 

list. Complete the calibration steps in the 

dialog box. Replace the pH probe if 

necessary. 

Store the pH electrode in storage solution 

when not in use. See Table 16 for 

recommended storage solutions.

Tip:  See Storing the pH Electrode on 

page 241 for information about storing 

the electrode.

Table 15. NGC instrument maintenance schedule, continued

Interval Component Action
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As Needed

Tubing and connectors Replace all tubing and connectors.

Pressure monitors Calibrate the monitors. Start ChromLab 

software and select Tools > Calibrate. 

Complete the calibration steps in the dialog 

box.

pH electrode Check the values for slope and offset. Start 

ChromLab software and select Tools > 

Calibrate and choose pH from the dropdown 

list. Complete the calibration steps in the 

dialog box. Replace the pH probe if 

necessary. 

Store in storage solution when not in use. 

See Table 16 for recommended storage 

solutions for the pH electrode.

Tip:  See Storing the pH Electrode on 

page 241 for information about storing 

the electrode.

Wash housing check 

valves

Replace the wash housing check valves.

Sample pump Calibrate flow rate of the sample pump.

Sample pump seals and 

check valve

Replace the seals and check valve using the 

pump head maintenance kit.

System pump Calibrate the flow rate.

System pump seals and 

check valve

Replace the seals and check valve using the 

pump head maintenance kit.

UV, UV/Vis, and 

conductivity monitors

Check the reference and signal voltage.

Replace the light source if necessary.

Calibrate the conductivity monitor.

UV/Vis flow cell Replace the flow cell if it is fouled and 

cannot be cleaned.

Table 15. NGC instrument maintenance schedule, continued

Interval Component Action
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Recommended Cleaning and Storage Solutions

Table 16 lists the recommended cleaning and storage solutions for the proper care 

of the NGC instrument.

Table 16. Cleaning and storage solutions for the NGC instrument

Component Solution to use

Outside surface Water or window cleaner on lint-free towelette

Caution: Do not spray water or other cleaning 

solutions directly onto the surface of instrument.

See Cleaning the Outer Surfaces of the NGC 

Instrument on page 166.

Fluidics system 1 N NaOH followed by filtered water rinse

Pump wash 20% ethanol or 20% IPA

Column storage Refer to manufacturer’s recommendations

NGC system storage 20% ethanol or 20% IPA

pH electrode storage  pH electrode storage buffer or pH 7 standard 

buffer

 1:1 mixture of 4 M potassium chloride or 

1 M potassium nitrate and pH 4 buffer

Detector flow cells 2 ml of 2% Contrad (catalog #176-4118)

Let sit for 10 min. Flush with water followed by 20% 

ethanol.
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System and Sample Pumps

The NGC system’s gradient pump system consists of two dual-piston pumps 

(system pumps A and B). The pumps form linear salt gradients over a set volume or 

period of time at a controlled flow rate.

The NGC system’s sample pump is a dual-piston pump used to load large sample 

volumes onto a column or to fill large sample loops. 

The system pumps and the sample pump are also equipped with a piston wash 

system. The piston wash system continuously rinses the area behind the pump 

seals to prolong the life of the pump head seal.

Components of the NGC Pumps

The illustrations in this section show the components of the pumps on the NGC 

systems: 

 Pump head assembly

 Pump head housing

 Pump head check valves, inlet and outlet 

 Pump head seal and small washer

 Piston wash assembly

 Piston wash housing

 Left wash housing inlet and outlet check valves

 Right wash housing inlet and outlet tubing fittings 

 Piston wash seal and large washer 

 Sealing O-rings

 Pistons
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Pump Head Assembly

 

LEGEND

1 Outlet check valve housing 2 Pump head small washer

3 Pump head seal 4 Inlet check valve housing

5 Check valve capsule 6 Pump head housing
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Piston Wash Assembly 

LEGEND

1 Fitting 2 Piston base

3 Piston 4 Wash housing large washer

5 Wash housing seal 6 Wash housing inlet check valve 

7 Wash housing O-ring 8 Wash housing (flow direction up)

9 Wash housing outlet check valve
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Disassembling the Pumps

The system and sample pumps can be disassembled to clean or replace their 

components. 

This section explains how to

 Remove the pump heads

 Remove the wash housing

 Remove the piston

Removing the Pump Heads

Caution: Flush any hazardous material from the system with water or an 

appropriate cleaning solvent. Remove the buffer and wash system inlet tubing 

from their bottles to avoid siphoning fluids during disconnection.

To remove the pump heads

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the tubing from the pump head inlet and outlet check valve 

housings.

Tip:  It is not necessary to disconnect the wash housing inlet and outlet 

tubing at this time.
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3. Use the 3/16" hex key that is provided in the fittings kit to remove the hex bolts 

on the front of the pump head housing.

Caution: Avoid pulling the pump head housing off at an angle or rocking 

or twisting the pump head housing, as this can cause the piston to break.

4. Carefully separate the pump head from the pump face plate. Pull the pump 

head straight toward you.
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5. Locate the wash housing O-ring and the pump head small washer. If you do not 

see them on the separated pump head:

 The O-ring might be attached to the wash housing.

 The small washer might have remained on the pump piston.

6. Remove and store the O-ring and small washer in a safe place such as a petri 

dish or other small container.

Tip:   You can remove the O-ring from its groove with a pair of tweezers if 

necessary. 

Note: Do not lose or damage the O-ring or small washer. The pump will 

not operate without them.

7. (Optional) Remove the inlet and outlet check valves on the pump head.

Tip:  It is not necessary to remove the inlet and outlet check valves unless 

you plan to clean or replace them. See To remove the pump head check 

valves on page 178.

8. (Optional) Replace the pump head seal. For more information, see To replace 

the pump head seal on page 183.
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9. (Optional) Inspect and clean the piston.

Note: To replace the piston, you must remove the wash housing. For more 

information, see Removing the Wash Housing on page 185.

To clean the pump heads

1. Remove the pump head inlet and outlet check valves as explained in To remove 

the pump head check valves on page 178.

2. Immerse the entire pump head in an ultrasonic cleaner.

3. Sonicate the pump head with a standard cleaning solution for about 5 min, or 

as necessary.

4. Rinse the pump head thoroughly with deionized water.

5. Reassemble the pump head. See Reassembling the Pumps on page 191.

6. Insert the outlet lines into a waste bottle.

7. Run the pump at 1 ml/min with deionized water for about 15 min to ensure that 

the seals are seated.

To remove the pump head check valves

1. Hold each pump head housing so its OUT check valve is on the top.

Tip:  In this position, the IN check valve housing is on the bottom of the 

pump head housing.
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2. Unscrew each IN check valve housing and pull it down out of the pump head.

You should have removed a total of two IN check valve housings and four 

check valve capsules. If one of the capsules remains in the pump head, use 

tweezers to remove it.

3. Turn the pump head housings upside down with the OUT check valve on the 

bottom. 

4. Unscrew each OUT check valve housing and pull it out of the pump head.

You should have removed a total of two OUT check valve housings and four 

check valve capsules. If one of the capsules remains in the pump head, use 

tweezers to remove it.

5. Set the IN and OUT check valve housings and capsules in a safe location.

To assemble the pump head check valves

1. Locate two check valve capsules for each check valve that you are assembling. 

Note: If you are assembling the IN and OUT check valves for both pump 

heads, you need eight capsules.

2. Carefully observe each capsule. The arrow on the side of each capsule 

indicates the flow direction. Ensure you insert the capsules with the arrows 

pointing in the direction of flow.
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3. Insert two check valve capsules into each IN check valve housing so the arrow 

on each capsule points in the direction of flow (away from the cap on the IN 

check valve).

4. Insert two check valve capsules into each OUT check valve housing so the 

arrow on each capsule points in the direction of flow (toward the cap on the 

OUT valve).
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To install the pump head check valve assemblies

1. To determine the inlet and outlet pump head housing ports, place the two pump 

head housings side by side with the flat sides touching.

2. Insert an IN check valve assembly into the bottom port of each pump head 

housing and hand tighten firmly.

3. Turn the pump head upside down so that the IN check valve is on top.
Instrument Guide  |  181



A  |  Maintaining the Instrument
4. Insert an OUT check valve assembly into the open port on each pump head 

and hand tighten firmly.
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To replace the pump head seal

1. Insert the seal removal end of the small seal tool in the seal cavity on the pump 

head.

The seal removal end is long and thin. It has a barbed tip to catch the seal.

2. Pull the seal out of the head.

3. Place the new seal on the other end of the seal tool.

The seal insertion end is shorter than the removal end. The tip is smooth, not 

barbed like the removal end.

4. Carefully align the seal with the seal cavity on the pump head.

5. Insert the seal tool in the pump head so that the open side of the seal enters 

first and push until the seal is completely seated in its cavity.
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6. Remove the seal tool and inspect the pump head to verify that the exposed 

small seal surface is lower than the surrounding pump head housing.
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Removing the Wash Housing

To remove the wash housing

1. Complete the steps in the section Removing the Pump Heads on page 175. 

2. Disconnect inlet and outlet tubing from both the left and right wash housings.

3. Observe the black arrow on the side of each wash housing. The arrows indicate 

the direction of wash flow.

 On the left housing, the arrow points upward.

 On the right housing, the arrow points downward.

Tip:  Before removing the wash housings, label them Left and Right to 

easily identify them when you reassemble the piston wash housing.

Caution: Be careful not to break or damage the piston.

4. Carefully remove the wash housing. Pull it straight out from the piston.

5. (Optional) Remove the left wash housing inlet and outlet check valves.

Tip:  It is not necessary to remove the inlet and outlet check valves unless 

you plan to replace them. See To replace the wash housing check valves 

on page 189.

6. Store the wash housing in a safe place.
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Removing the Piston

Caution: Use extreme caution when removing the piston. The sapphire piston 

can easily break if dropped or bent.

To remove the piston

1. Complete the steps in the sections Removing the Pump Heads on page 175 

and Removing the Wash Housing on page 185. 

2. Remove the wash housing seal from the piston if it did not detach with the 

wash housing.

Store the wash housing seal in a safe place such as a petri dish or other small 

container if you plan to reuse it.

3. Remove the large washer from the piston.

a. Locate the small flathead screwdriver provided in the fittings kit.

b. Insert the screwdriver into the flat area behind the large washer.

c. Gently slide the large washer away from the front panel with the 

screwdriver until you can reach it with your fingers.

4. Gently pull the large washer off the piston. Store the washer in the same 

container as the wash housing seal.
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5. Gently grasp the piston by its metal base and carefully lift the piston straight up 

to dislodge it from its carrier.

The left side of the following image shows a completely disassembled pump 

panel.
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6. Rinse the piston and examine it for damage.

7. Store the piston in the same container as the large washer and the wash 

housing seal.

To replace the wash housing seal

1. Insert the seal removal end of the large seal tool in the seal cavity on the pump 

head.

The seal removal end is long and thin. It has a barbed tip to catch the seal.

2. Pull the seal out of the head.

3. Place the new seal on the other end of the seal tool.

The seal insertion end is shorter than the removal end. The tip is smooth, not 

barbed like the removal end.

4. Carefully align the seal with the seal cavity on the pump head.

5. Insert the seal tool in the pump head so that the open side of the seal enters 

first and push until the seal is completely seated in its cavity.

6. Remove the seal tool and inspect the pump head to verify that the exposed 

wash housing seal surface is lower than the surrounding wash housing.
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To replace the wash housing check valves

1. Identify the left and right wash housings.

 The wash system has two wash housings for each pump. The left housing 

has check valves connected at the inlet and outlet ports. It is installed on 

the pump with the arrow (flow direction) pointing up.

 The right wash housing has empty fittings connected at the inlet and outlet 

ports. The right housing is installed with the arrow (flow direction) pointing 

down.
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To identify the left and right housings after you remove them from the pump, 

remove a fitting on one of the wash housings. If the fitting is a check valve then 

the housing is the left housing. If the fitting is hollow then the housing is the 

right housing.

Tip:  You might have labeled the wash housings Left and Right in the 

section To remove the wash housing on page 185.

2. Locate one inlet and one outlet piston wash check valve for the left wash 

housing.

Note: You do not need to clean or replace the fittings on the right wash 

housing. 

3. Remove the left wash housing check valves.

Caution: The inlet and outlet check valves must be oriented correctly 

when installed or the pump can be damaged. 

4. Identify the inlet and outlet check valves.

 The inlet check valve has an X on the male end.

 The outlet check valve has a round insert in the male end.

5. Insert the inlet check valve in the bottom of the wash housing (inlet port). 

6. Insert the outlet check valve into the top of the wash housing (outlet port).

7. Remove the right wash housing fittings.

8. Insert a new fitting into the top and bottom ports on the right wash housing.
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Reassembling the Pumps

This section explains how to

 Insert the piston

 Install the wash housing

 Install the pump heads

Inserting the Piston

Caution: Use extreme caution when inserting the piston. The sapphire piston 

can easily break if dropped or bent.

To insert the piston

1. Holding the metal piston base, carefully slide the base into its carrier until it is 

securely seated.

2. Slide the large washer onto the piston. Push it back as far as it will go.
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Installing the Wash Housing

Before installing the wash housing, ensure that

 The large washer is installed on the piston and pushed all the way back

 The wash housing seal is installed in the wash housing

To insert the wash housing

1. If you removed the left wash housing check valve see To replace the wash 

housing check valves on page 189.

2. Reinstall the wash housing O-rings if you removed them. Ensure the O-rings are 

fully inserted into the O-ring grooves.

3. Identify the left and right wash housings. Remove a fitting on one of the wash 

housings. If the fitting is a check valve then the housing is the left housing. If the 

fitting is hollow then the housing is the right housing.

Tip:  You might have labeled the wash housings Left and Right in the 

section To remove the wash housing on page 185.
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4. Position the left wash housing with its arrow pointing up and carefully slide it 

into place over the piston.

5. Position the right wash housing with its arrow pointing down and carefully slide 

it into place over the piston.

6. Connect a pump wash tubing to the top left and right wash housing ports.

7. Connect an inlet tube to the bottom left wash housing inlet port.

8. Connect a priming tube to the bottom right wash housing port.

9. Tighten the tubing fittings with a fittings tightener.
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Installing the Pump Heads

Note: When installing new pump heads, ensure that you install two pumps of 

the same flow rate (that is, either two F10 pumps or two F100 pumps). Do not 

mix the pump heads.

To install the pump heads

1. If you removed the inlet and outlet check valves from the pump head, insert the 

valves and firmly tighten each one.

For more information about replacing the check valves, see To remove the 

pump head check valves on page 178.

2. Locate the small washer and O-ring that you stored.

3. Slide the small washer onto the piston and push it back as far as it will go.

4. If necessary, insert the O-ring into the groove on the wash housing.

5. Verify that the pump head seal is securely fitted in each pump head.
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6. Identify the pump head assemblies. To identify the left and right pump heads, 

position both pump heads so the front of the pump head faces you and the 

check valve OUT ports are visible.

 The left pump head has a straight edge on its right side. 

 The right pump head has a straight edge on its left side. 

Caution: Do not force the pump head into place. If the pump head does 

not slide onto the housing easily, pull out the pump head and examine it for 

any obstruction.

7. Slide the pump head over the studs on the pump face and gently push it into 

place on the piston.
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8. Push on the center of the pump head to seat it firmly against the pump face.

9. Using the hex key, firmly tighten the hex bolts (alternating from one bolt to the 

other) while centering the pump head.

10. Reconnect the buffer inlet and outlet tubing and tighten with a fittings tool. 

11. Prime the system. See To plumb and prime the system pump wash lines on 

page 291 or To plumb the sample pump on page 292 as appropriate.
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Replacing the Priming Manifold Check Valve

The procedure for replacing the priming manifold check valve on F100 pumps is 

different than on F10 pumps and sample pumps. The priming manifold check valve 

capsule on F10 and sample pumps is inserted into the priming manifold outlet port. 

The priming manifold check valve on F100 pumps is prepressed into the check 

valve housing.

The procedures in this section explain how to replace the priming manifold check 

valves for the different systems.

To replace the priming manifold check valve and capsule on F10 and 

sample pumps

1. Unscrew the priming manifold outlet port check valve housing (labeled OUT).
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2. Using a pair of tweezers, remove the check valve capsule from inside the 

priming manifold outlet port.

3. Locate a new check valve capsule for the priming manifold check valve in the 

housing replacement kit. 

4. Carefully observe the capsule. The arrow on the side of the capsule indicates 

the flow direction. Ensure that you insert the capsule with the arrow pointing in 

the direction of flow (upward).
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5. Using the tweezers, insert the new check valve capsule into the port.

Note: Ensure that the capsule is upright before inserting the check valve 

housing.
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6. Carefully insert the OUT check valve housing in the priming manifold outlet port 

and hand tighten firmly.
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To replace the priming manifold check valve on F100 pumps

Important: The F100 pumps contain a translucent O-ring spacer below the 

check valve housing in the priming manifold port. You must replace the spacer 

(catalog #100-48178_SVC) when you replace the F100 check valve housing.

1. Unscrew the priming manifold outlet port check valve housing (labeled OUT).

2. Using a pair of tweezers, carefully remove the translucent O-ring from within the 

check valve port.

3. Locate a new check valve housing and translucent O-ring spacer for the 

priming manifold check valve. 

4. Carefully observe the housing. The check valve should be pressed into the 

bottom.

5. Using the tweezers, insert the O-ring spacer into the check valve port and 

ensure that it lies flat. 
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6. Carefully insert the OUT check valve housing in the priming manifold outlet port 

and hand tighten firmly.
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Conditioning New Seals

New seals should be conditioned before use. To condition the seals, run the pump 

with wetted seals under controlled flow rate and pressure conditions. This allows 

the seals to seat properly and proof against leaks.

Important: Use only organic solvents to condition new seals. Buffer solutions 

and salt solutions should never be used to condition new seals. Recommended 

solvents are HPLC-grade methanol and IPA or aqueous mixtures of these 

solvents. 

To condition the seals

1. Using a backpressure regulator or a suitable column, run the pump with a 50:50 

solution of IPA (or methanol) and water for 30 min at the backpressure and flow 

rate listed in Table 17 for the pump head type.

2. At the end of the 30-min treatment, run the pump for an additional 15 min at the 

backpressure and flow rate listed in Table 18.

Table 17. Initial backpressure and flow rates for conditioning seals

Pump Type Backpressure Flow Rate

10 ml/min 2,000 psi 2 ml/min

100 ml/min 1,000 psi 2 ml/min

Table 18. Secondary backpressure and flow rates for conditioning seals

Pump Type Backpressure Flow Rate

10 ml/min 3,250 psi 4 ml/min

100 ml/min 1,300 psi 5 ml/min
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Mixer

Replacing the Mixer Components

The NGC system’s mixing chamber volume can be adjusted so that it is optimized 

for the flow rate being used. See Table 2 on page 72 for supported flow rates.

The mixer comprises the following components:

 Mixer top

 Mixer base

 Magnetic stir bar

 Bolts

 Mixer barrel (optional)

 Sealing O-rings
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Disassembling the Mixer

Use this procedure to replace any of the components of the mixer.

Important: Before disassembling the mixer, flush any hazardous material from 

the NGC system. Ensure that the pumps are not running and bleed residual 

pressure from the system. 

To disassemble the mixer

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the tubing from the top, bottom, and sides of the mixer.
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3. Twist the mixer assembly clockwise approximately 1/8 turn and lift it upward to 

remove it from the socket.

4. Tilt the mixer assembly over a container to drain any residual fluid from the 

mixer.

5. Using the hex key that is provided in the fittings kit, remove the four hex bolts 

on the bottom of the mixer base.
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6. Separate the mixer top from the mixer base and barrel extension (if used).
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To change the O-rings

1. Locate the O-ring in the groove on the mixer base and the mixer barrel 

extension (if used).

2. With your finger, pry the O-ring out of the groove.

3. Insert the replacement O-ring in the groove.

Note: If you are using only the mixer body, then only one O-ring is 

required. If a mixer barrel extender is used, two O-rings are required.
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To replace or exchange the mixer barrel

Tip:  If you are replacing the mixer barrel, store the current mixer barrel and the 

hex bolts in your accessories kit or another safe place.

1. Locate the replacement mixer barrel.

2. Ensure that the O-ring on the mixer base is in its groove and that the stir bar is 

properly seated.

3. With the O-ring on the mixer base facing up, place the required mixer barrel 

extension on the mixer base with its O-ring facing up.

Note: Ensure that the four bolt holes on the barrel align with the bolt holes 

in the base.
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To clean the mixer body

1. Wipe the inside of the mixer body with a lint-free towel.

2. Soak and sonicate the following components in a bath of mild detergent for 

about 15 min:

 Mixer barrel extension

 O-rings

 Magnetic stir bar

Tip:  The stir bar is magnetic. To remove it, turn the mixer base upside 

down and gently tap it on the benchtop or tabletop.
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Reassembling the Mixer

Tip:  To reinsert the magnetic stir bar, place it on a tabletop and carefully place 

the mixer base over it. Ensure that the magnetic stir bar lies flat in the mixer 

base.

To reassemble the mixer

1. Place the mixer top onto the top of the mixer base assembly.

Note: Ensure that the four bolt holes on the bottom of the mixer top align 

with the four bolt holes on the top of the mixer base assembly.

2. Insert the four hex bolts into the bolt holes on the bottom of the mixer base.
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3. Using the hex key, firmly tighten the hex bolts. Alternate by tightening opposite 

bolts (tighten Bolt 1, then Bolt 3; Bolt 2, then Bolt 4).

4. Insert the mixer assembly into the socket and fasten it by twisting it counter-

clockwise until it clicks.

5. Reconnect the tubing to the top, bottom, and sides of the mixer and ensure 

that they are secure.

6. Restart the NGC instrument.
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The Detectors

Replacing the UV Flow Cell

The NGC systems ship with a 5 mm UV flow cell installed. Additional flow cells for 

analytical (10 mm) and preparative (2 mm) applications are available. This section 

explains how to change or replace the UV flow cell. 

The procedure is the same for the single-wavelength UV and multi-wavelength  

UV/Vis detectors. The procedure is slightly different for the multi-wavelength 

UV/Vis II detector. This section explains how to change the UV flow cell on all three 

detectors.

Replacing the Multi-Wavelength UV/Vis II Flow Cell

Important: Replacement flow cells are shipped in static resistant packaging. 

Store the replacement flow cells in the original packaging until needed. 

Afterwards, Bio-Rad suggests that you store the original flow cell in the static 

resistant packaging in which the replacement cell was shipped.
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Three main components comprise the integrated multi-wavelength UV/Vis and 

conductivity monitor:

LEGEND

1 Detector head 2 Combination UV flow cell and 

conductivity monitor unit

3 Optical base 4 Bolts on optical base

5 Thumbscrews
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The NGC systems ship with a 5 mm UV flow cell installed. The flow cells are 

identified by an embossed mm value on the right side of the flow cell, for example: 

Note: The shape of the 5 mm flow cell differs slightly from that of the 2 mm and 

10 mm flow cells. Take care when selecting the replacement flow cell. Ensure 

you are selecting the correct cell for the type of application.

To replace the multi-wavelength UV/Vis II flow cell

1. Remove the replacement combination UV flow cell/conductivity monitor from 

its static resistant packaging and place on top of the packaging.
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2. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

3. Disconnect the inlet and outlet tubing from the UV cell that is attached to the 

NGC system.

Note: The bottom fitting is angled. Take care when disconnecting and 

connecting the bottom fitting.

Important: With a soft cloth, wipe off excess liquid on the body of the 

detector to prevent seepage before proceeding.

4. Loosen both thumbscrews on the front of the detector head at the same time.

5. Firmly grasp the right and left side the detector head and pull it straight out and 

off the UV flow cell/conductivity monitor unit and place it to the side.
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Tip:  The thumbscrews remain attached to the detector head.

6. Firmly grasp the right and left side the UV flow cell/conductivity monitor unit 

and pull it straight out and off the guide pins on the optical base. 

7. With the UV number on the right side, install the replacement UV flow cell/

conductivity monitor unit onto the guide pins on the optical base.

8. Insert the original UV flow cell/conductivity monitor unit into the static resistant 

packaging in which the replacement cell was shipped and seal the package.
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9. Align the bolts on the detector head with the holes on the replacement UV flow 

cell/conductivity monitor unit and firmly press it into place.

10. Tighten both thumbscrews at the same time. The thumbscrews should be 

finger tight.

11. Reconnect the 1/4-28 fittings and tubing to the top and bottom of the flow cell 

and ensure that they are secure.

12. Restart the NGC instrument.

Replacing the Multi-Wavelength UV/Vis Flow Cell

To replace the multi-wavelength UV/Vis flow cell

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the inlet and outlet tubings from the UV cell.

3. With the screwdriver supplied in the fittings kit, loosen the two bolts on the UV 

flow cell.
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4. Firmly grasp the bolts on the flow cell and lift the flow cell from its socket.

5. Verify that the square gasket is removed with the flow cell.

Tip:  If the gasket is not on the flow cell, look inside the socket. The rubber 

gasket might have remained in the groove inside the socket. Remove the 

gasket and place it onto the flow cell that you removed.

6. Store the flow cell with the attached gasket and bolts in a safe, clean place for 

future use.
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7. Locate the flow cell. The flow cell should include

 Two bolts

 One square rubber gasket

8. Place the flow cell into the socket on the UV monitor.

Note: Ensure that the arrow on the top of the flow cell is pointing to the 

right, and that the two bolts on the flow cell align with the bolt holes in the 

socket. The guides on the bottom of the flow cell help to prevent inserting 

the flow cell incorrectly.
Instrument Guide  |  221



A  |  Maintaining the Instrument
9. Tighten the bolts. If necessary, use the screwdriver.

10. Reconnect the 1/4-28 fittings and tubing to the top and bottom of the flow cell 

and ensure that they are secure.

11. Reconnect the tubing lines to the conductivity monitor.

12. Restart the NGC instrument.
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Replacing the Single Wavelength UV Flow Cell

To replace the UV flow cell

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the inlet and outlet tubings from the UV cell.

3. With the screwdriver supplied in the fittings kit, loosen the two bolts on the UV 

flow cell.

4. Firmly grasp the bolts on the flow cell and lift the flow cell from its socket.
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5. Verify that the square gasket is removed with the flow cell.

Tip:  If the gasket is not on the flow cell, look inside the socket. The rubber 

gasket might have remained in the groove inside the socket. Remove the 

gasket and place it onto the flow cell that you removed.

6. Store the flow cell with the attached gasket and bolts in a safe, clean place for 

future use.

7. Locate the flow cell. The flow cell should include

 Two bolts

 One square rubber gasket

8. Place the flow cell into the socket on the UV monitor.

Note: Ensure that the arrow on the top of the flow cell is pointing to the 

right, and that the two bolts on the flow cell align with the bolt holes in the 

socket. The guides on the bottom of the flow cell help to prevent inserting 

the flow cell incorrectly.

9. Tighten the bolts. If necessary, use the screwdriver.
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10. Reconnect the 1/4-28 fittings and tubing to the top and bottom of the flow cell 

and ensure that they are secure.

11. Reconnect the tubing lines to the conductivity monitor.

12. Restart the NGC instrument.

Replacing the Single-Wavelength UV Detector LED

This section explains how to replace the LED on the single-wavelength UV detector.

Caution: It is strongly suggested that you wear gloves when you replace the 

LED. Do not touch the LED glass with bare hands, as oils from your skin will 

degrade the lamp over time.

To replace the single-wavelength UV LED 

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the tubing lines from the top and bottom of the UV cell.

3. Disconnect the tubing lines from the conductivity monitor.

4. The door to the LED is held in place by a pressure latch. Press down on the 

latch and then slide the door forward.
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Tip:  The door is tethered to the casing. It will hang to the side while you 

replace the lamps.
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You see the LED module with three thumbscrews. The LED itself is on the other 

side of the board.

5. Completely loosen the top right thumbscrew.
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6. Loosen the left thumbscrews, alternating one turn on the top left screw then 

one turn on the bottom left screw until they are completely loosened.

Tip:  You might need to loosen the left two screws with a flathead 

screwdriver.

7. Grasp the thumbscrews and pull the LED board straight forward out of the 

casing.

WARNING!  Use caution when removing the LED board. The LED might 

be hot to the touch after the board is removed.
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The following image shows the LED housing without the LED board.

8. Dispose of the used LED in an appropriate waste receptacle.

9. Locate the new LED and remove it from its packing material. 
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10. Align the thumbscrews of the replacement LED with the holes on the housing 

and carefully insert the LED into the casing.

11. Tighten the three thumbscrews to secure the lamp into the casing.

12. Slide the door to the LED casing into place until the latch secures.

13. Reconnect the tubing lines to the top and bottom of the UV cell.

14. Reconnect the tubing lines to the conductivity monitor.

15. Restart the NGC instrument.

Back of LED Board

Front of LED Board
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Resetting the Single-Wavelength Lamp Time Details

The system tracks the lamp usage and displays the details on the Detector tab in 

the System Information dialog box in ChromLab.

After you change the single-wavelength lamps, you must reset the lamp time details 

in the system so that the details are current.

To reset single wave-length lamp time details

1. Start ChromLab.

2. Do one of the following:

 On the ChromLab computer, from the System Control tab open File > 

System Information and select the Detector tab.

 On the touch screen, open System Information from the menu and select 

the Detector tab.

3. Click Reset Lamps Time.

4. Restart the NGC instrument.

The values for lamp time hours for the single-wavelength UV lamps reset to 0.0 hr.
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Replacing the Multi-Wavelength UV/Vis Detector 
Lamps 

This section explains how to replace the deuterium lamp or tungsten lamp inside the 

multi-wavelength UV/Vis detector. The replacement lamp unit includes the lamp, 

cable connector, and plug. The lamp is replaced as a unit.

Caution: It is strongly suggested that you wear gloves when you replace the 

lamps. Do not touch the lamp glass with bare hands, as oils from your skin will 

degrade the lamp over time.

WARNING!  Use caution when removing the lamps. The lamps might be hot to 

the touch after the module is removed.

To replace the multi-wavelength UV/Vis lamps

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the tubing lines from the top and bottom of the UV cell.

3. Disconnect the tubing lines from the conductivity monitor.

4. Remove the multi-wavelength UV/Vis detector module from the instrument.

See Replacing or Repositioning Modules on the NGC Instruments on page 251 

for information about removing a module.

5. Using a screwdriver, loosen the screw and remove the door on the left side of 

the module.
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The deuterium and tungsten lamps are both accessible.

Tip:  You might need to unscrew the cable connector for the tungsten 

lamp to access the collar to the cable connector for the deuterium lamp. 
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6. Remove the lamp:

WARNING!  Use caution when removing the lamps. The lamps might be 

hot to the touch after the module is removed.

a. Using your fingers, loosen the collar on the cable plug.

b. Pull the plug upward to disconnect the cable.
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c. With a 2.5 mm hex key, remove the screws on the top and bottom of the 

lamp casing.

d. Gently pull the lamp casing and lamp out of the socket.

The following image shows a completely disassembled deuterium lamp 

unit.

e. Dispose of the used lamp in an appropriate waste receptacle.

7. Locate the replacement lamp and remove it from its packaging.

8. Carefully insert the replacement lamp fixture into the socket.

9. Align the screw holes on the lamp unit with the screw holes in the case.

10. Using the 2.5 mm hex key, tighten the screws to secure the lamp unit.
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11. Insert the cable plug and tighten the collar.

Tip:  The deuterium lamp plug has seven connector pins, the tungsten 

lamp has five.

12. Replace the access door and tighten the screw with a Phillips screwdriver.

13. Slide the multi-wavelength UV/Vis module into its bay and fasten it in place by 

tightening the two screws.

14. Reconnect the tubing lines to the top and bottom of the UV cell.

15. Reconnect the tubing lines to the conductivity monitor.

16. Restart the NGC instrument.

Note: The multi-wavelength UV/Vis detector will go through an automated 

calibration routine when the system is restarted.

Replacing the Conductivity Monitor

Note: The conductivity monitor on the multi-wavelength UV/Vis II module is 

integrated with the flow cell. To change the conductivity monitor, see the 
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section Replacing the Multi-Wavelength UV/Vis II Flow Cell on page 214.

The images in this section show the conductivity monitor on the single-wavelength 

UV detector module. Though the position of the conductivity monitor differs on the 

multi-wavelength UV/Vis module, the steps to replace the conductivity monitor are 

the same.

To replace the conductivity monitor

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Disconnect the tubing lines from the conductivity monitor.

3. Loosen the two thumbscrews on the front of the detector.
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4. Firmly grasp the detector and pull it toward you to detach it.

5. Dispose of the detector in an appropriate waste receptacle.

6. Locate the replacement detector and remove it from its packaging.

7. Align the two thumbscrews with the screw holes and the pin holes to the pins 

on the instrument.

Tip:  The thumbscrews are on the top of the detector. There are two guide 

bolts on the bottom of the detector.

Caution: Do not bend or break the connector pins.
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8. Gently push the detector onto the connector pins on the instrument.

9. Tighten the thumbscrews to secure the detector in place.

10. Reconnect the tubing lines to the conductivity monitor.

11. Restart the NGC instrument.

Note: The conductivity monitor will go through an automated calibration 

routine when you restart the system.
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pH Probe

Storing the pH Electrode

When not in use, store the pH electrode in storage solution. See Table 16 on 

page 171 for recommended storage solutions. 

Tip:  Set the pH valve to Bypass mode until it is needed. This ensures the pH 

electrode remains in storage.

To store the pH electrode

1. Start ChromLab software.

2. Choose Tools > Calibrate to open the Calibration dialog box.

3. Select pH on the Calibrate dropdown list.

4. Press Start to set the pH monitor to Calibration mode.

5. On the pH valve, inject approximately 10 ml of pH electrode storage solution 

through the Cal In port.

6. Click Close to close the Calibration dialog box.

Note:  You might see a ChromLab message warning you about 

interrupting calibration. You can safely ignore this message. Any previous 

calibration performed on the pH valve is saved.

Cleaning the pH Electrode

To remove soluble contaminants

 Sequentially immerse the electrode in the following solutions for 1 min each:

 0.1 M HCl

 Distilled H2O

 0.1 M NaOH

 Distilled H2O

 0.1 M HCl
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To remove lipophilic organic contaminants

 Immerse the electrode in an organic solvent or a liquid detergent, for example

 Bio-Rad cleaning concentrate, catalog #161-0722

 2% Contrad, catalog #176-4118

Replacing the pH Probe

The replacement pH probe is packaged in storage solution to protect it during 

shipping.

To replace the pH probe

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Loosen the nut on the DNS cable and disconnect it from the DNS connector on 

the front of the pH module. 
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3. Loosen the black collar on the pH probe.

4. To remove the pH probe, lift the probe out of the pH flow cell.

Dispose of the probe in an appropriate waste receptacle.

5. Add a small amount of water (2 ml) to the pH flow cell.

6. Locate the replacement pH probe and remove it from the storage solution.

7. Ensure that the pH probe cord is threaded through the collar.

8. Inspect the probe to determine if the air bubble in the stem has moved into the 

bulb area.

Tip:  If bubbles are visible in the bulb area, hold the electrode by the top 

cap and shake it downward to move the bubbles into the stem.

9. Carefully remove the plastic cap from the pH probe and ensure that the O-ring 

is in place on the body.

Caution: Use caution when removing the plastic cap so as not to damage 

the glass probe.

10. Insert the probe into the top of the pH flow cell.

11. Slide the collar over the pH probe onto the pH valve and hand-tighten the collar 

until it is snug.

Caution: Do not overtighten the collar. Overtightening will break the glass 

pH probe.

12. Connect the pH probe cable to the DNS connector on the pH valve module.

13. Restart the NGC instrument.

14. Calibrate the pH monitor. See Calibrating pH on page 162 for more information.
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Other Components

Attaching an Expansion Tier to the NGC Instrument

WARNING!  Disconnect power to the NGC instrument before attaching an 

expansion tier. Do not attempt to service any component on the NGC 

instrument unless noted in this manual. Contact Bio-Rad for service requests.

To attach the connector cable, you will need access to the back of the NGC 

instrument. If necessary, pull the NGC instrument away from the wall and rotate the 

instrument to gain access.

Important: If you are adding a fourth expansion tier, you must attach it to an 

already attached third tier. The third and fourth tiers are not interchangeable. 

Ensure that the third tier is installed on the NGC instrument before attaching the 

fourth tier. 

To attach an expansion tier to the NGC instrument

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. Remove all tubing lines to sample and buffer bottles and remove any bottles 

from the buffer tray.

3. Lift the top off the NGC instrument and place it on the lab bench.
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Tip:  The buffer tray can remain inside the top.

4. Locate the package that contains the expansion tier and 52" (1.32 m) 

connector cable.

Important: The cables that ship with third and fourth tiers are not 

interchangeable. You must use the cable that ships with the expansion tier. 

Inserting a third tier cable into the fourth tier connector ports will damage 

the cable and the ports.

 The catalog number for the 25" (63.5 cm) second-to-third tier connector 

cable is #100-24878.

 The catalog number for the 52" (1.32 m) third-to-fourth tier connector 

cable is #100-24892.

5. Carefully remove the tier from its packaging material.

6. Place the expansion tier on top of the already installed tier.

Tip:  Although the images in this section show how to attach the fourth 

expansion tier to an already installed third tier, the procedure for attaching 

a third tier to a second tier is the same. These images are examples.
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7. Locate the connector cable that ships with the expansion tier.

8. View the connector ends. Each end is beveled. The direction of the bevel 

determines the tier into which to insert the connector:

 The end with the bevel slanting up inserts into the upper tier’s connector 

port.

 The end with the bevel slanting down inserts into the lower tier’s connector 

port.

Fourth expansion tier 

Previously attached 

third tier 
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For example:
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9. Firmly press the clips inward and insert the appropriate connector into the 

upper tier’s connector port.

Tip:  You hear a click when the connector is properly seated. 
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10. Insert the other connector into the lower tier’s connector port.

11. Place the top, with the buffer tray, on top of the NGC instrument and place the 

buffer bottles into the buffer tray.

12. Insert tubing lines into the sample and buffer bottles.
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13. Perform the following tasks:

Task: Refer to the section:

Insert modules into the new 

tier

Replacing or Repositioning Modules on the 

NGC Instruments on page 251

Plumb the system Plumbing NGC Systems on page 288

Start the instrument Starting the NGC Instrument on page 131

Prime the system Priming and Purging the Systems on page 135

Calibrate the system Calibrating the NGC Instrument on page 162
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Replacing or Repositioning Modules on the NGC 
Instruments

WARNING!  Disconnect power to the NGC instrument before removing or 

repositioning any module. Do not attempt to service any component on the 

NGC instrument unless noted in this manual. Contact Bio-Rad for service 

requests.

WARNING!  To reduce the chance of liquid seeping into the instrument, all 

open bays must be filled with the NGC Blank module (catalog #788-4005). The 

NGC instrument will not operate if it detects a slot without a module inserted.

To replace or reposition modules on the NGC instruments

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument.

2. If necessary, disconnect all tubing lines to and from the module that you plan to 

replace or reposition.

3. Loosen the captive screws on the front of the installed module.

4. Firmly grasp both screws on the module and pull it forward out of its bay.
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The following image shows an empty bay.

5. Store the module and the screws in a safe place for future use.

Tip:  If you received a replacement module from Bio-Rad, use the 

packaging provided with your shipment to return the damaged module to 

Bio-Rad.

6. (Optional) Convert the bay to single wide or double wide. 

See Converting Bays to Fit Modules on page 255.

7. Locate the module that you plan to install and remove it from its packaging.
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8. The frame of the bay has tracks on the top and bottom of the right side. The 

module has guide rails on the top and bottom right side.

Align the rails on the module with the tracks in the bay to properly guide it into 

position.

9. Place the module into the open bay and gently push it in as far as it will go. 

Note: Each module has an alignment pin on the back to ensure that it 

aligns correctly with the main communication board. 

10. Ensure that the screw holes on the module align with the screw holes on the 

bay.

11. Insert the screws that shipped with the module into the screw holes.

12. Tighten the screws to secure the module.

Bottom of ModuleTop of Module
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13. Perform the following tasks:

Task: Refer to the section:

Plumb the system Plumbing NGC Systems on page 288

Start the instrument Starting the NGC Instrument on page 131

Prime the system Priming and Purging the Systems on page 135

Calibrate the system Calibrating the NGC Instrument on page 162
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Converting Bays to Fit Modules

Some modules fit into single-wide bays while others require double-wide bays (such 

as the system and sample pump modules and the UV and UV/Vis detector 

modules). Bays can be converted from one size to the other by adding or removing 

the center divider.

The following image shows two adjacent, empty, single-wide bays.
Instrument Guide  |  255



A  |  Maintaining the Instrument
To convert a single-wide bay to a double-wide bay

1. Complete steps 1–5 in the section To replace or reposition modules on the 

NGC instruments.

2. Gently lift the divider upward off of the lip to unhook it and then pull it out of the 

instrument.

3. Store the divider in a safe place for later use.

4. Complete steps 7–12 in the section To replace or reposition modules on the 

NGC instruments.
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To convert a double-wide bay to a single-wide bay

1. Locate a divider.

2. Complete steps 1–5 in the section To replace or reposition modules on the 

NGC instruments on page 251.

3. Insert the top of the divider into its slot.

4. Gently bend the divider and slide the bottom of the divider up onto the lip.

5. Complete steps 7–12 in the section To replace or reposition modules on the 

NGC instruments.
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Cutting Replacement Tubing

Tip:  Use the tubing cutter provided in the fittings kit. The cutter produces a 

flat, clean cut, which is important in making a fitting.

To cut replacement tubing

1. Use the outer portion of the blade on the tubing cutter to cut the tubing to the 

approximate length.

2. Insert the tubing into the hole in the tubing cutter and cut the end of the tubing 

smooth and square.

3. View the stainless steel lock ring to determine how to position it on the tubing.

Lock rings have an internal taper. The wall at one end is thinner than on the 

other end.

 

Ensure that the thin (tapered) end faces the ferrule and the thick end faces the 

fitting nut.
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4. Slide the fitting nut, lock ring, and the ferrule, in that order, onto the tubing.

Note: The stainless steel lock ring is not in the fluid path, so 

biocompatibility is maintained.

5. Extend the tubing slightly beyond the end of the ferrule.

6. Use the fittings tightener (supplied in the fittings kit) to seat and tighten the 

ferrule onto the tubing.

a. Insert the assembly into one of the ports on the fittings tightener.

b. Turn the fitting nut clockwise until it is finger tight.

c. When the fitting is tight, turn the fitting nut counter-clockwise to remove 

the ferrule from the fitting tightener port.

7. View the tip of the tube and ferrule and ensure that they are aligned before use.
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Installing the Backpressure Regulator

The NGC systems ship with a 20 psi backpressure regulator in the accessories kit. If 

the column requires a high backpressure, you will have to install the backpressure 

regulator.

Caution: Do not use the backpressure regulator with low pressure columns, as 

this will result in damage.

To install the backpressure regulator

1. Install the backpressure regulator between the conductivity monitor and the pH 

detector (if one is in use).

Note: Ensure that the arrow on the backpressure regulator points in the 

direction of the flow.

2. Connect the tubing to the top and bottom of the new backpressure regulator.
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To remove the backpressure regulator

1. Disconnect the tubing from the top and bottom of the installed backpressure 

regulator.

2. Store the backpressure regulator in a safe place.

3. Do one of the following:

 Attach a Tefzel union to the open tubing in place of the backpressure 

regulator.

 Replace the two open tubes with a single tubing line.

Attach one end of the tubing to the top of the conductivity monitor and the 

other end to either the pH flow cell or the NGC Fraction Collector (NGC FC) 

or BioFrac fraction collector.
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Repositioning the Touch Screen

This procedure explains how to move the touch screen from one side of the NGC 

instrument to the other.

To reposition the touch screen 

1. On the touch screen, select Shut Down on the dropdown menu to exit 

ChromLab and shut down the NGC instrument. 

2. Disconnect the monitor cable from the touch screen connector port on the 

back of the instrument.

Unscrew the thumbscrews and firmly pull the cable out of the connector port. 

3. Locate the Phillips screwdriver that is provided in the accessories kit.
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4. Remove the side mount cover from the side of the instrument on which you 

plan to attach the touch screen.

Note: The top section in this image is a third tier. (The NGC Discover 

system is a 3-tier system.) The touch screen is attached at the top of the 

second tier. If you have an NGC Quest or an NGC Scout system, you will 

not have a third tier. Locate the side mount cover at the top of the second 

tier.

5. Remove the screws that secure the right and left side cable trough covers to 

the back of the instrument.

Tip:  Set these components aside. You will use them in the steps that 

follow.
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6. Remove the display cable from the side and rear cable troughs on the 

instrument.

7. Using the hex key labeled Pumphead, remove the hex bolt from underneath the 

touch screen mount.
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8. Lift the touch screen display off the mounting post.

9. Place the touch screen monitor face down on a clean surface to prevent 

scratching.

10. Remove the touch screen mount and attach it to the other side of the NGC 

instrument.
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11. Using the 7/64 hex key provided in the accessories kit, remove the cover from 

the back of the touch screen monitor.

12. Using a Phillips screwdriver, remove the six screws that attach the touch screen 

to the pivot arm assembly and place them aside.

13. Lift the pivot arm assembly off of the touch screen. The mounting assembly 

should be in your right hand.
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14. Turn the pivot arm assembly around 180° so that the mounting assembly is now 

in your left hand and insert the assembly into its position on the back of the 

touch screen.

15. Using the six screws that you removed in step 12, reattach the pivot arm 

assembly to the touch screen with a Phillips screwdriver.

16. Reattach the cover to the back of the touch screen with the 7/64 hex key.

17. Pivot the touch screen so that the screen faces forward and the cable 

connector is at the bottom of the screen. 

18. Slide the touch screen display onto the mounting post.

19. Insert the ¼-20 x ¾" hex bolt underneath the mount to secure the touch 

screen.
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20. Route the display cable through the side and rear cable troughs on the 

instrument.

21. Locate the cable trough covers and slide mount cover that you removed in 

step 5 on page 263.

22. Slide the cable trough covers into place and secure them to the back of the 

instrument with 6-32 x 1¼" Phillips screws.

23. Insert the side mount cover on the side of the instrument from which you 

removed the touch screen.

24. Insert the touch screen cable into the touch screen connector port on the back 

of the instrument and tighten the thumbscrews.
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This appendix lists potential problems and suggested solutions for the NGC 

chromatography systems. You can obtain more information about your system by 

registering for Consult Bio-Rad at www.bio-rad.com, where an online technical 

support service offers an extensive database of frequently asked questions (FAQs).

Note: To troubleshoot other Bio-Rad instruments and devices, such as the 

NGC Fraction Collector, the BioFrac fraction collector, or the C-96 autosampler, 

refer to their separate documentation.

System and Sample Pumps

Symptom Possible Cause Possible Solution

The pumps do not 

deliver the correct flow 

rate.

The pumps might be out of 

calibration.

Recalibrate the pumps. Start 

ChromLab software and select 

Tools > Calibrate Pump Flow 

Rate. Complete the calibration 

steps in the dialog box.

The incorrect pump heads might 

be mounted.

 In ChromLab, verify that the 

fluidic scheme shows the 

correct configuration.

 Verify that you are using the 

correct pump heads for the 

method.
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The pumps do not 

deliver the correct flow 

rate (continued).

The fittings or tubing sizes might 

be wrong.

Note: It is important to use 

the recommended tubing and 

fitting sizes.

 For information about tubing 

specifications, see Table 6, 

NGC system tubing details, on 

page 89.

 For information about column 

fittings, see Table 8, Supported 

column fittings, on page 91.

Check system pumps A and B 

and the buffer blending or 

sample inlet valves:

 Ensure that the inlet lines to 

system pumps A and B are 

tight.

 If the buffer blending or 

sample inlet modules are 

installed, ensure that all 

tubing connections are 

secure.

The pump might not be receiving 

buffer.

Verify that buffer is flowing to 

the pump:

 Ensure that the pump inlet 

lines are immersed in buffer.

 Ensure that the buffer bottles 

are positioned at or above the 

level of the NGC instrument.

Tip:  Place buffer bottles in 

the buffer tray at the top of 

the instrument.

 Ensure that all inlet fittings 

are secure.

 Ensure that all inlet filters are 

clean.

 Reprime the pumps to 

remove air that might be 

trapped in the system.

For more information, see 

Priming and Purging the 

Systems on page 135.

Symptom Possible Cause Possible Solution
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The pumps do not 

deliver the correct flow 

rate (continued).

Air bubbles might be trapped in 

the pump heads, causing erratic 

liquid delivery.

Note: Always degas buffers 

before use by stirring them 

vigorously under vacuum for 

approximately 20 min.

Important: Use a 

heavy-wall, side-arm 

Erlenmeyer flask, as standard 

flasks might implode under 

vacuum.

 Inspect the inlet lines, ensure 

that the fittings are tight to 

prevent air from leaking into 

the system.

 Reprime the pumps to 

remove air that might be 

trapped in the system.

For more information, see 

Priming and Purging the 

Systems on page 135. 

Symptom Possible Cause Possible Solution
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The pumps do not 

deliver the correct flow 

rate (continued).

The pump seals or check valves 

might be fouled.

Tip:  Replace the check 

valves on a regular basis, 

depending on the usage and 

type of solution or sample 

pumped through the pump 

head. See Table 15, NGC 

instrument maintenance 

schedule, on page 168. 

 Use an ultrasonic cleaner and 

a mild detergent solution and 

then rinse with water to 

recondition the pump seals 

and check valves.

 Perform CIP to clean the 

pump seals and check 

valves. 

See the NGC Chromatography 

Systems and ChromLab 

Software User Guide for more 

information.

  Replace the pump seals.

See Disassembling the Pumps 

on page 175.

 Replace the check valves.

See Disassembling the Pumps 

on page 175.

Note: Recalibrate the 

pumps after cleaning the 

system or replacing the 

check valves. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

Liquid continuously 

leaks from the pump 

head washout drain 

trough.

The pump head seals are worn or 

damaged.

Replace the pump head seals 

on both pump heads.

Note: Recalibrate the 

pumps after changing the 

seals. In ChromLab, select 

Tools > Calibrate > Pump 

Flow Rate. Complete the 

calibration steps in the 

dialog box.

Symptom Possible Cause Possible Solution
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Liquid continuously 

leaks from the pump 

head washout drain 

trough (continued).

The check valves might need to 

be replaced.

Replace badly clogged or 

damaged check valves.

Note: Recalibrate the 

pumps after replacing 

check valves. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

The screws that secure the pump 

heads are not tight.

Replace the wash housing small 

seal.

Note: Recalibrate the 

pumps after changing the 

seals. In ChromLab, select 

Tools > Calibrate > Pump 

Flow Rate. Complete the 

calibration steps in the 

dialog box.

The backpressure 

drops to zero or is 

much lower than 

expected.

The flow rate setting might have 

changed.

Confirm that the flow rate 

setting has not changed.

Tubing or fittings might be leaking. Inspect all tubing and fitting 

connections, especially at the 

pump inlet.

The pump seals might need to be 

replaced.

Tip:  A buildup of crystallized 

buffer salts on the rear of the 

pump head indicates that the 

seals need to be replaced.

Replace pump seals.

See Disassembling the Pumps 

on page 175.

Symptom Possible Cause Possible Solution
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The backpressure 

drops to zero or is 

much lower than 

expected (continued).

The check valves might need to 

be cleaned or replaced.

 Perform CIP to clean the 

check valves.

See the NGC Chromatography 

Systems and ChromLab 

Software User Guide for more 

information.

 Replace check valves. 

See Disassembling the Pumps 

on page 175.

No pressure (psi) 

reading, or the psi 

value always reads 

zero.

The pumps might not be running. Verify that the pumps are 

running, and that the inlet lines 

are primed and not pulled out of 

the buffer reservoirs. Check the 

fittings for leaks.

The inlet lines are not primed, or 

there is a problem with the buffer 

flow.

In ChromLab, open the Sample 

Inject Valve dialog box and 

verify that the buffer flow is 

going to the column and not to 

waste.

The “zero pump pressure” 

calibration routine might have 

been used while the system was 

under pressure.

Stop the system pumps and 

disconnect the line from the 

pump to the inject valve so that 

the pressure transducer in the 

pump module is definitely at 

zero psi.

Note: Recalibrate after 

stopping the pumps. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

Symptom Possible Cause Possible Solution
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System and Sample Pumps
Backpressure values 

are higher or lower than 

expected. 

The flow rate might have changed. In ChromLab, verify that the 

pump is set to deliver the 

correct flow rate.

Note: Recalibrate after 

stopping the pumps. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

The column might need to be 

cleaned, or a frit might need to be 

replaced.

 Remove the column and run 

the pumps to determine if the 

high backpressure is due to 

the column. 

 Consult the column’s user 

manual for the cleaning 

procedure.

Note: Recalibrate after 

stopping the pumps. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

The pressure transducer 

calibration might be incorrect.

 Inspect the tubing path for 

obstructions.

 Change the tubing in the 

tubing path if necessary. 

Note: Recalibrate after 

stopping the pumps. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box. 

Symptom Possible Cause Possible Solution
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Backpressure values 

are higher or lower than 

expected (continued).

The inline filter is clogged. Inspect the inline filter and 

replace if necessary.

Note: Recalibrate after 

stopping the pumps. In 

ChromLab, select Tools > 

Calibrate > Pump Flow 

Rate. Complete the 

calibration steps in the 

dialog box.

Unintended increase in flow rate. In ChromLab, verify that the 

flow rate setting is correct.

Particulate matter has 

accumulated in the system, 

causing a resistance to flow.

Tip:  Prevent or minimize 

high backpressure by filtering 

buffers and samples and by 

changing the pump seals 

before they deteriorate 

completely.

Isolate the blockage in the 

system tubing. Loosen the 

connection fittings at the 

detector and work backwards 

toward the column and pump 

head.

The rinse fluid is not 

circulating.

The tubing lines are not connected 

or the fittings are not tight.

Ensure that the wash system 

tubing lines are connected 

properly and reprime the 

system.

The rinse fluid reservoir 

is overflowing.

Fluid is leaking past the pump 

head seals into the wash system.

Replace the pump head seal.

Symptom Possible Cause Possible Solution
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UV or UV/Vis Detector
UV or UV/Vis Detector

Symptom Possible Cause Possible Solution

The UV baseline is 

unstable or noisy.

The UV baseline shows 

a reproducible zig-zag 

or sawtooth trace.

Air bubbles are trapped in the flow 

cell.

Note: Always degas buffers 

and solutions before use.

 Degas buffers by stirring 

vigorously under vacuum for 

approximately 20 min.

Important: Use a 

heavy-wall, side-arm 

Erlenmeyer flask, as 

standard flasks may 

implode under vacuum.

 Plumb the detector with the 

column outlet connected to 

the bottom of the flow cell. 

This forces air bubbles to rise 

to the top of the flow cell and 

dissipate.

 Use the 20 psi backpressure 

regulator supplied with the 

NGC system to remove most 

air bubbles. Place it directly 

after the conductivity flow cell 

and run buffer for several 

minutes.

If the chosen column cannot be 

run with the backpressure 

regulator, and air bubbles are a 

continuing problem (for example, 

during some affinity 

chromatography steps), use the 

2 mm path length flow cell. The 

straight line flow of the flow cell 

makes it easier to remove 

bubbles.
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The UV baseline is 

unstable or noisy 

(continued).

The UV baseline shows 

a reproducible zig-zag 

or sawtooth trace 

(continued).

UV or UV/Vis lamps are dirty or are 

close to the end of their usable 

life.

Check the lamp usage values in 

the System Information dialog 

box:

1. From the System Control tab 

in ChromLab open File > System 

Information > Detector tab.

2. Click Get Lamp Status.

Use the lamp usage values 

(close to 2,000 hours for the 

deuterium and tungsten lamps; 

close to 5,000 hours or 100% 

PWM for LEDs) to determine if 

the lamps are nearing their end 

of life.

To change the UV flow cell see 

Replacing the UV Flow Cell on 

page 214.

To change the lamps:

 See Replacing the Single-

Wavelength UV Detector LED 

on page 225

 See Replacing the Multi-

Wavelength UV/Vis Detector 

Lamps on page 233

Note: For more information 

about the Detector tab, see 

the chapter System Control 

in the NGC 

Chromatography Systems 

and ChromLab Software 

User Guide.

Excessive pump 

pulsations exhibit as 

regular noise on the 

baseline.

Air bubbles trapped in the pump 

heads can produce exaggerated 

pulsations, which appear as noisy 

UV baselines.

Purge the pump heads to 

remove bubbles.
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UV or UV/Vis Detector
Baseline noise 

continues when pumps 

are turned off.

External environmental influences 

can cause noise spikes.

If the spikes occur at regular 

intervals (for example, every 

20– 30 sec), check for the 

presence of heating baths, 

drying ovens, or other heating 

devices on the same electrical 

circuit or in close proximity to the 

NGC system. Turn off these 

devices to see if the problem 

goes away.

The UV trace will not 

zero.

 Air bubbles are present in the 

flow cell.

 The flow cell is dirty.

 Clean the interior of the flow 

cell by passing 1 M sodium 

hydroxide (NaOH), water, 

methanol, and/or 0.5 M 

HMnO3 or other mineral acid 

through the cell. Dry the 

interior of the cell with a 

stream of high purity nitrogen 

gas (never use “house” 

compressed air as it can 

contain oil droplets).

Tip:  Alternatively, inject 2 

ml of Contrad (catalog 

#176-4118) and let sit for 10 

min. Flush cell with water 

followed by 20% ethanol.

 Condensation can occur on 

the exterior windows of the 

flow cell when the optics unit 

is moved from the lab to a 

cold room and vice versa. 

Always allow an equilibration 

period to compensate for 

such temperature effects.
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The baseline is drifting. The eluant is nonhomogeneous 

perhaps due to poor mixing or 

flow rate variation.

 Check the flow rates of both 

system pumps.

 Recalibrate both system 

pumps. In ChromLab, select 

Tools > Calibrate > Pump 

Flow Rate. Complete the 

calibration steps in the dialog 

box.

The column equilibration is slow. Certain ion exchangers are slow 

to re-equilibrate, especially when 

just sanitized. Allow a longer 

equilibration period.

If drift is due to a higher 

absorbance, UV absorbing 

material might be leaching from 

the column.

To confirm this, remove the 

column and run deionized water 

or an aqueous nonabsorbing 

buffer. If the baseline is stable, 

then the column is suspect.

Tip:  Consult the column’s 

user manual for cleaning 

procedures.

Negative peaks are 

present.

The sample is applied to the 

column in a buffer that is different 

from that used to equilibrate and 

elute the column. Refractive index 

changes might be responsible for 

the negative peaks.

Apply the sample in the same 

buffer used to equilibrate the 

column.

The elution buffer might have a 

higher UV absorbance than the 

sample components.

Verify the UV absorbance of the 

elution buffer.

Symptom Possible Cause Possible Solution
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UV or UV/Vis Detector
Sample trace values 

are lower than 

expected.

The lamps might be nearing the 

end of their usable life.

Check the lamp usage values in 

the System Information dialog 

box. From the System Control 

tab in ChromLab open File > 

System Information > Detectors 

tab.

If the lamp usage values are 

close to their limits 

(approximately 2,000 hours for 

the deuterium and tungsten 

lamps; approximately 5,000 

hours for LEDs), change the 

lamps.

 For single-wavelength LEDs, 

see Replacing the Single-

Wavelength UV Detector LED 

on page 225.

 For multi-wavelength lamps, 

see Replacing the Multi-

Wavelength UV/Vis Detector 

Lamps on page 233.
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Conductivity Monitor

Symptom Possible Cause Possible Solution

Conductivity values are 

higher or lower than 

expected. 

The conductivity monitor might 

need calibration.

Recalibrate the conductivity 

monitor. In ChromLab, select 

Tools > Calibrate > Conductivity 

Monitor. Complete the 

calibration steps in the dialog 

box.

Note: The relationship 

between the conductivity 

reading and salt 

concentration is not linear. 

The curve will flatten out at 

higher salt concentrations.

Gradient conductivity 

trace is distorted. 

The mixer capacity is incorrect. See Table 2, Flow rates of 

supported mixer barrels for the 

F10 pumps, on page 72 for 

information about mixer barrel 

sizes.

See Replacing the Mixer 

Components on page 204.
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pH Probe

Symptom Possible Cause Possible Solution

The pH readings are 

higher or lower than 

expected.

The pH probe might need to be 

calibrated.

Recalibrate the pH probe. In 

ChromLab, select Tools > 

Calibrate > pH. Complete the 

calibration steps in the dialog 

box.

The pH readings are 

noisy or unstable.

Air bubbles might be present in 

the pH probe flow cell.

 Flush the system to remove 

air bubbles.

 Check the values for slope 

and offset. If they are not 

within specifications, replace 

the pH probe.

The pH trace is drifting. The temperature of the solution 

is changing.

Allow all solutions to come to 

thermal equilibrium.

Note: Ensure that the 

instrument and all solutions 

are equilibrated to the same 

temperature.

The pH response is slow. The pH electrode is 

contaminated or worn.

Clean or replace the probe.
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Buffer Blending Valve

Column Switching Valve

Symptom Possible Cause Possible Solution

Liquid leaks out from the 

drain plug at the bottom 

of the module.

Liquid is building up inside the 

module.

Shut down the system and call 

Bio-Rad Technical Support.

Symptom Possible Cause Possible Solution

Pressure sensors read 

>0–1 psi when the NGC 

system is idle.

 With regular use, pressure 

sensor values may drift over 

time.

 Rebooting NGC systems may 

cause the column switching 

valve to lose calibration.

 Recalibrate the column switch 

valve. In ChromLab, select 

Tools > Calibrate > Column 

Switching Valve Pressure. 

Complete the calibration 

steps in the dialog box.

 Reset the pressure values for 

the column switch value to 

factory settings. In ChromLab, 

select Tools > Calibrate > 

Column Switching Valve 

Pressure. Click Reset to 

factory.
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External Devices
External Devices

Symptom Possible Cause Possible Solution

Unable to zero an 

external device 

connected to SIM 1 or 

SIM 2 ports on the signal 

import module (SIM).

Incorrect readings from 

an external device 

connected to SIM 1 or 

SIM 2 ports.

Possible voltage offset between 

the negative and ground input 

terminals on the SIM.

Install a jumper between the 

negative and ground terminals 

on the SIM 1 or SIM 2 ports.

See To connect an external 

device to the SIM 1 and SIM 2 

ports on page 119.

Unable to connect to the 

NGC Fraction Collector 

(NGC FC) or BioFrac 

fraction collector.

 The fraction collector is not 

turned on. 

 The NGC instrument loses 

connection to the fraction 

collector.

 The fluidic scheme includes 

the fraction collector.

 Power on the external device 

and click Retry on the dialog 

box that appears.

 Power off both instruments 

and then restart them in this 

order:

    1. The fraction collector

    2. The NGC instrument

 Select a fluidic scheme that 

does not include the fraction 

collector.
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C Plumbing the System
With the exception of the inlet tubing, waste lines, and column, the NGC systems 

ship preassembled and preplumbed with the modules necessary to perform 

gradient separations. The inlet and waste lines should be plumbed during the 

installation process. 

However, as your needs change, you can reconfigure your NGC system by inserting 

and removing modules. After you reconfigure your system, you will have to replumb 

the modules.
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Plumbing NGC Systems

Several plumbing tasks are required for all system configurations. Other tasks are 

specific to the configuration. This section explains how to plumb each instrument 

configuration.

General Guidelines for Tubing Sizes

The NGC systems use three sizes of tubing. Use the information in Table 19 to 

select the appropriate tubing.   

Note: When plumbing the system, keep tubing lengths to a minimum. Also, all 

fittings should be finger tight. Do not overtighten, or you risk damaging the 

connection. Bio-Rad offers tubing clips of different sizes in the accessories kit. 

For outlet tubing longer than 6", attach a tubing clip in close proximity to the 

fitting to keep tubing in place in the event that it detaches from the fitting.

Table 19. NGC system tubing sizes

Use Tubing Dimensions Tubing 
Material

Fittings Vol/cm

Prepump 1/8" OD x 0.062" ID

(3.2 mm OD x 1.6 mm ID)

Clear

PTFE

Super flangeless for 1/

8" (3.2 mm) OD tubing

20 μl

Postpump 

with F10 

pump head

1/16" OD x 0.020" ID

(1.6 mm OD x 0.51 mm ID)

Orange

PEEK

Super flangeless for 1/

16" (1.6 mm) OD 

tubing

2 μl

Postpump 

with F100 

pump head

1/16" OD x 0.030" ID

(1.6 mm OD x 0.76 mm ID)

Green

PEEK

Super flangeless for 1/

16" (1.6 mm) OD 

tubing

4.5 μl
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Plumbing All NGC Systems

Tip:  Bio-Rad recommends inserting a Delrin or Tefzel 1/4–28 flat-bottom plug, 

included in the fittings kit, into unused valve ports to prevent particles from 

entering the valve.

Table 20 lists the tasks for plumbing all NGC systems. The tasks are explained in 

detail in the sections that follow. 

 Sample loop

 Injection port

 Waste lines (2)

Plumbing the System Pumps Wash Lines

All configurations ship with the pump wash system preplumbed except for the inlet 

and outlet tubing. Plumbing the inlet and outlet tubing is specific to the type of 

pump (system pump configuration or sample pump). The following images display a 

detailed view of the connectivity and flow direction of the rinse solution through the 

tubing segments for the system pumps and the sample pump.

Table 20. Plumbing tasks for all NGC systems

Task

1. Inlet tubing to the pump head wash port on system pump A

2. Pump head wash priming line to the pump head wash port on 

system pump B

3. 1/4-28 union to priming line on system pump B

4. Pump head wash inlet to the 1/4-28 union attached to the pump head 

wash priming line on system pump B

5. On the sample inject valve:

6. Tube #2 from the outlet on the conductivity flow cell to the inlet on the 

20 psi backpressure regulator
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System Pumps Wash Flow

Sample Pump Wash Flow
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To plumb and prime the system pump wash lines

1. Mount a tube holder to the right or left side of the instrument in either the upper 

or lower rack slots.

2. Fill a 50 ml tube with 20% isopropanol (IPA) and insert it in the tube holder.

Tip:  You can use 20% ethanol as an alternative.

3. Connect inlet tubing to the pump wash inlet port (left rear port) on 

system pump A.

 

4. Immerse the other end of the pump A wash inlet tubing in the tube of 20% IPA.

5. Connect the pump head wash priming tubing to the outlet (right rear port) on 

system pump B.

6. Connect a 1/4-28 female to female luer adapter to the pump head wash 

priming tubing.

7. Connect a 1/4-28 union to a second inlet tubing. You will use the inlet tubing as 

the outlet tubing for system pump B.

Tip:  Set the inlet tubing with the attached union aside. Keep it close by, as 

you will attach it to the pump head wash priming tubing on step 12.
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C  |  Plumbing the System
8. Attach a 30 ml syringe to the 1/4-28 female to male luer adapter.

9. Withdraw the plunger on the syringe until liquid is visible in the syringe.

10. Detach the luer adapter and syringe from the pump head wash priming tubing 

on pump B.

11. Locate the second inlet tubing with the 1/4-28 union that you set aside in 

step 7.

12. Connect the union to the pump head wash priming tubing on system pump B.

13. Immerse the other end of the inlet tubing in the tube of 20% IPA.

To plumb the sample pump

Perform the steps in the section To plumb and prime the system pump wash lines 

on page 291 with the following exception:

 Attach the inlet tubing to the left rear port on the sample pump, and the pump 

head wash priming tubing to the right rear port. 
292  |  NGC Chromatography Systems and ChromLab Software



Plumbing NGC Systems
Plumbing the Sample Inject Valve

To plumb the sample inject valve

1. Connect waste tubing to waste ports Waste 1 and Waste 2 on the sample inject 

valve.

2. Connect an injection port to the center of the sample inject valve.

3. Connect the sample loop to ports Loop E and Loop F on the inject valve.
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Attaching the Backpressure Regulator

If your column requires a high backpressure, install the backpressure regulator.

To attach the backpressure regulator

1. Connect Tube #2 to the top of the conductivity monitor.

2. Connect the other end of Tube #2 to a 20 psi backpressure regulator.

Note: The backpressure regulator has a raised arrow on its side. Ensure 

that the arrow on the regulator points in the direction of the flow.
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Plumbing the NGC Quest System

Table 21 lists the tasks for plumbing the NGC Quest system. The tasks are 

explained in detail in the sections that follow. 

Note: Ensure that you complete the plumbing tasks in the section Plumbing All 

NGC Systems on page 289 before continuing.

The figure on page 296 shows the Point-to-Plumb connections for the NGC Quest 

system.

Table 21. Plumbing tasks for the NGC Quest system

Tasks

1. Inlet tubing to the system pump A inlet manifold

2. Inlet tubing to the system pump B inlet manifold

3. Connect one of the following:

 Tube #4 from the 20 psi backpressure regulator to the lower port on 

the inlet side of the NGC Fraction Collector (NGC FC) magnetic union

 Tube #4 from the 20 psi backpressure regulator to the Common inlet 

port on the BioFrac fraction collector diverter valve
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NGC Quest Point-to-Plumb Connections
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To plumb the system pumps

1. Connect inlet tubing to the inlet manifold of system pump A.

2. Connect inlet tubing to the inlet manifold of system pump B.

3. Immerse the open ends of both inlet tubing in a bottle of degassed, deionized 

water.

To plumb the fraction collector

1. Connect Tube #4 to the open end of the 20 psi backpressure regulator that you 

connected to the conductivity monitor in step 2 on page 294.

2. Connect the other end of Tube #4 to one of the following: 

 The lower port on the inlet side of the NGC FC magnetic union

 The Common inlet port on the BioFrac fraction collector diverter valve
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Plumbing the NGC Scout System

Table 22 lists the tasks for plumbing the NGC Scout system. The tasks are 

explained in detail in the sections that follow.

Note: Ensure that you complete the plumbing tasks in the section Plumbing All 

NGC Systems on page 289 before continuing. 

The figure on page 299 shows the Point-to-Plumb connections for the 

NGC Scout system.

Table 22. Plumbing tasks for the NGC Scout system

Tasks

1. Inlet tubing to ports Q1–Q4 on the buffer blending valve

2. Waste tubing to the calibration outlet port (Cal Out) on the pH valve

3. Pump head wash priming line to the calibration inlet port (Cal In) on pH 

valve

4. Tube #2 from the 20 psi backpressure regulator to the inlet port on the 

pH valve

5. Connect one of the following:

 Tube #4 from the outlet port on the pH valve to the lower port on the 

inlet side of the NGC FC magnetic union

 Tube #4 from the outlet port on the pH valve to the Common inlet port 

on the BioFrac fraction collector diverter valve
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NGC Scout Point-to-Plumb Connections
Instrument Guide  |  299



C  |  Plumbing the System
To plumb the buffer blending valve

 Connect the inlet tubing to ports Q1–Q4 on the buffer blending valve.

Note: The buffer inlet tubing is color-coded to identify the different buffer 

solutions.

The color scheme for the tubing and ports is defined as follows: 

To plumb the pH valve

1. Connect the pump head wash priming tubing to the Cal In port on the pH valve.

2. Connect waste tubing to the Cal Out port on the pH valve.

Tubing color Port Solution

Green Q4 High salt buffer

Yellow Q3 Water

Blue Q2 Buffer base

Red Q1 Buffer acid
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3. Immerse the open end of the waste tubing in the waste container.

4. Connect Tube #2 from the 20 psi backpressure regulator that you connected in 

step 2 on page 294 to the inlet port (In) on the pH valve.

5. Connect one end of Tube #4 to the outlet port (Out) on the pH valve. 

6. Connect the other end of Tube #4 to one of the following:

 The lower port on the inlet side of the NGC FC magnetic union

 The Common inlet port on the BioFrac fraction collector diverter valve

Tip:  To clean the pH valve, immerse the outlet lines into a waste container and 

the inlet lines into cleaning solution. Perform the system wash step in 

ChromLab as explained in the section System CIP (Clean in Place) — Storage 

Parameters in the NGC Chromatography Systems and ChromLab Software 

User Guide.
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Plumbing the NGC Discover System

Table 23 lists the tasks for plumbing the NGC Discover system. The tasks are 

explained in detail in the sections that follow. 

Note: Ensure that you complete the plumbing tasks in the section Plumbing All 

NGC Systems on page 289 before continuing.

The figure on page 303 shows the Point-to-Plumb connections for the 

NGC Discover system.

Table 23. Plumbing tasks for the NGC Discover system

Tasks

1. Inlet tubing to the left pump head wash port on the sample pump 

2. Pump head wash priming line to the right pump head wash port on the 

sample pump

3. 1/4-28 union to the pump head wash priming line on the sample pump

4. Inlet tubing to the other end of the 1/4-28 union on the sample pump

5. Inlet tubing to ports Q1–Q4 on the buffer blending valve

6. Inlet tubing to the remaining ports on the buffer inlet valves

7. Inlet tubing to the inlet manifold on the sample pump

8. Waste tubing to the Cal Out port on the pH valve

9. Priming line to the calibration inlet port (Cal In) on the pH valve

10. Tube #2 from the 20 psi backpressure regulator to the inlet of the pH 

valve

11. Connect one of the following:

 Tube #4 from the outlet port on the pH valve to the lower port on the 

inlet side of the NGC FC magnetic union

 Tube #4 from the outlet port on the pH valve to the Common inlet port 

on the BioFrac fraction collector diverter valve
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NGC Discover Point-to-Plumb Connections
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To plumb the buffer blending valve

 Connect the inlet tubing to ports Q1–Q4 on the buffer blending valve.

Note: The buffer inlet tubing is color-coded to identify the different buffer 

solutions.

The color scheme for the tubing and ports is defined as follows: 

Tubing color Port Solution

Green Q4 High salt buffer

Yellow Q3 Water

Blue Q2 Buffer base

Red Q1 Buffer acid
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To plumb the buffer inlet valves

1. Connect tubing from Outlet A on the buffer blending valve to port 8/BB on 

buffer inlet valve A.

2. Connect tubing from Outlet B on the buffer blending valve to port 8/BB on inlet 

valve B.

3. Connect tubing from the Out port on inlet valve A to the inlet manifold of system 

pump A.

4. Connect tubing from the Out port on inlet valve B to the inlet manifold of 

system pump B.

5. (Optional) Connect inlet tubing to ports 2–7 on both buffer inlet valves A and B.

To plumb the sample pump

1. Connect inlet tubing to the sample pump inlet manifold.

2. Immerse the other end of the inlet tubing in a bottle of degassed, deionized 

water.

3. Connect outlet tubing to the Sample Pump port on the sample inject valve.
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To plumb the pH valve

1. Connect the pump head wash priming tubing to the Cal In port on the pH valve.

2. Connect waste tubing to the Cal Out port on the pH valve.

3. Immerse the other end in the waste container.

4. Connect Tube #2 from the 20 psi backpressure regulator that you connected in 

step 2 on page 294 to the inlet port (In) on the pH valve.

5. Connect one end of Tube #4 to the outlet port (Out) on the pH valve. 

6. Connect the other end of Tube #4 to one of the following:

  The lower port on the inlet side of the NGC FC magnetic union

 The Common inlet port on the BioFrac fraction collector diverter valve
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Plumbing the NGC Discover Pro System

Table 24 lists the tasks for plumbing the NGC Discover Pro system. The tasks are 

explained in detail in the sections that follow. 

Note: Ensure that you complete the plumbing tasks in the sections Plumbing 

All NGC Systems on page 289 and Plumbing the NGC Discover System on 

page 302 before continuing.  

The figure on page 308 shows the Point-to-Plumb connections for the 

NGC Discover Pro system.

Table 24. Plumbing tasks for the NGC Discover Pro system

Tasks

1. Tube #6 between the outlet port on the sample inlet valve and the 

inlet port on the sample pump

Note: Remove the inlet tubing from the sample pump inlet 

manifold if it is installed.

2. Connect one of the following:

 Tube #4 from O1 Port 1 to the lower port on the inlet side of the 

NGC FC magnetic union

 Tube #4 from O1 Port 1 to the Common inlet port on the BioFrac 

fraction collector diverter valve

 Waste tubing to O1 Port 1

3. Inlet tubing to the remaining ports on the sample inlet valve

See the section Plumbing Sample Inlet Valves on page 309.

4. Outlet tubing to the remaining ports on the outlet valve

See the section Plumbing Outlet Valves on page 310.
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Plumbing Sample Inlet Valves

Each sample inlet valve module includes all necessary tubing. The inlet tubing is 

approximately 5' (1.5 m) in length. Determine the length of inlet tubing you need and 

cut the tubing to the appropriate length.

Note: NGC inlet valves can be used for buffer or sample selection.

To plumb the sample inlet valves

1. If your system has only one sample inlet valve:

a. Connect tubing from the Out port on the sample inlet valve to the sample 

pump inlet manifold.

b. Connect inlet tubing to ports 1–8 as needed.
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2. If your system has two sample inlet valves:

a. Connect tubing from the Out port on sample inlet valve 1 (S1) to the 

sample pump inlet manifold.

b. Connect tubing from the Out port on sample inlet valve 2 (S2) to port 8 on 

S1.

c. Connect inlet tubing to ports 1–7 on S1 and to ports 1–8 on S2 as needed.

3.  Immerse the inlet tubing in sample containers.

Plumbing Outlet Valves

Each outlet valve module includes all necessary tubing. The tubing is approximately 

5' (1.5 m) in length. Determine the length of tubing you need and cut it to the 

appropriate length.

To plumb the outlet valves

1. If your system has only one outlet valve:

a. Connect tubing from the Out port on the conductivity monitor or pH 

monitor to the In port on the outlet valve.
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b. (Optional) Connect one of the following:

 Tube #4 from O1 Port 1 to the lower port on the inlet side of the 

NGC FC magnetic union

 Tube #4 from O1 Port 1 to the Common inlet port on the BioFrac 

fraction collector diverter valve

 Waste tubing to O1 Port 1and immerse in a waste container

c. Connect outlet tubing to the remaining ports as needed.

2. If your system has two outlet valves:

a. Connect tubing from the Out port on the conductivity monitor or pH 

monitor to the In port on outlet valve 1 (O1).

b. (Optional) Do one of the following:

 Tube #4 from O1 Port 1 to the lower port on the inlet side of the 

NGC FC magnetic union

 Tube #4 from O1 Port 1 to the Common inlet port on the BioFrac 

fraction collector diverter valve

 Waste tubing to O1 Port 1and immerse in a waste container

c. Connect tubing from port 12 on O1 to the In port on outlet valve 2 (O2).

d. Connect outlet tubing to all remaining outlet ports as needed.

3.  Immerse the outlet tubing in fraction collection containers.
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D Connecting the C-96 
Autosampler to NGC Systems
Using the C-96 Autosampler with NGC Systems

The C-96 autosampler enhances NGC chromatography systems, providing 

automated, accurate, and reproducible sample injections. Its easy-to-install 

accessories allow for a wide range of injection volumes from 5 μl–10 ml.

The signal import module (SIM) connects the C-96 autosampler to NGC systems. 

The SIM digitizes the analog signal from the C-96 autosampler and transmits the 

signal to the NGC system.

This appendix explains how to connect and set up the C-96 autosampler for use 

with the NGC instrument.

Tip:  To install and set up the C-96 autosampler, see its documentation. 

Connecting the C-96 Autosampler to an NGC System

To connect the autosampler to an NGC system

1. Ensure that both the NGC instrument and the C-96 autosampler are powered 

off.

2. Connect the SIM device to the NGC instrument. See Connecting the SIM to the 

NGC Instrument on page 117 for more information.

3. On the back of the SIM, firmly grasp the DIGITAL IN female connector and pull 

it straight out of its port.

4. Grasp the DIGITAL OUT male connector and pull it out of its port.
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5. Locate the two cables that connect the autosampler to the SIM:

 15-pin D connector cable (part #10027227)

 9-pin D connector cable (part #10027224)

These cables ship with the autosampler.

6. Attach the DIGITAL IN connector to the 15-pin D connector cable.

Tip:  The 15-pin D connector cable has three wires (red, black, and 

brown).

a. From left to right, loosen the first, second, and last screws on the 

connector.

b. If necessary, strip the plastic wire coating off the wires so that they are 

exposed.

c. Insert the wires into the open ports in this order and tighten the screws:

 Insert the red wire into the first port.

 Insert the black wire into the second port.

 Insert the brown wire into the last (ground) port.

Note: Take care not to overtighten or fray the wires.

7. Attach the DIGITAL OUT connector to the 9-pin D connector cable.

Tip:  The 9-pin D connector cable has two wires (red and black).

a. From left to right, loosen the first and last screws on the connector.

b. Insert the wires into the open ports in this order and tighten the screws, 

taking care not to overtighten or fray the wires:

 Insert the red wire into the last port.

 Insert the black wire into the first (ground) port.
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8. On the back of the autosampler:

a. Insert the 15-pin cable into the left (P1 RELAYS OUTPUTS) connector port 

and tighten the thumbscrews.

b. Insert the 9-pin cable into the right (P2 INPUTS) connector port and tighten 

the thumbscrews.

9. On the back of the SIM:

a. Insert the P1 RELAYS OUTPUTS cable into the DIGITAL IN port.

b. Insert the P2 INPUTS cable into the DIGITAL OUT port. 
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Plumbing and Priming the C-96 Autosampler

This section explains how to plumb the C-96 autosampler to the sample inject valve 

on the NGC instrument and to prime the autosampler after you plumb it. Before you 

plumb and prime, you must prepare the tubing. Use 1/16" PEEK tubing to plumb the 

autosampler to the sample inject valve.

For information about plumbing the autosampler, see the C-96 Autosampler for 

BioLogic DuoFlow Chromatography System Quick Start Guide or the C-96 

Autosampler for BioLogic DuoFlow Chromatography System User Manual.

To prepare the tubing

1. Cut two segments of 1/16" PEEK tubing of adequate length.

2. To one end of each segment, attach a 10-32 fitting. This fitting attaches to the 

autosampler.

3. To the other end of each segment, attach a 1/4-28 fitting. This fitting attaches to 

the sample inject valve.

To connect the tubing from the autosampler to the sample inject valve

1. Ensure that both the NGC instrument and the C-96 autosampler are powered 

off.

2. Attach one 10-32 fitting to Port 1 and the other 10-32 fitting to Port 6 on the 

autosampler.

3. Attach the 1/4-28 fitting from Port 1 to the Loop E port on the sample inject 

valve.

4. Attach the 1/4-28 fitting from Port 6 to the Loop F port on the sample inject 

valve.

5. Insert one 1/4-28 plug to the syringe port and another 1/4-28 plug to the Waste 

port (W1) on the sample inject valve.

6. Power on the NGC instrument and the autosampler.
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To prime and purge the C-96 autosampler

Note: Before priming the autosampler, ensure that any column is offline.

1. Immerse the inlet tubing in a container of buffer or HPLC grade (filtered, 

degassed) or other high quality water.

2. Use a syringe to prime the pumps. See the section Priming and Purging the 

Systems on page 135 for specific information.

3. On the ChromLab computer or the touch screen, start ChromLab in Manual 

mode.

4. Set the fluidic scheme to display the autosampler and sample inject valve.

5. In the fluidic scheme, touch or click the Sample Inject Valve module to open its 

dialog box.

6. Set the inject valve to System Pump Inject Loop.

Autosampler 

Sample Inject 

valve
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7. In the fluidic scheme, touch or click the System Pump module to open its 

dialog box.

8. In the System Pump dialog box:

a. Set Flow Rate to 5 ml/min.

b. (Optional) Set Duration to at least 2 min.

c. Click Start.
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Setting Up the C-96 Autosampler for Use in ChromLab 
Methods

This section briefly explains how to set up the autosampler for use in a ChromLab 

method. For information about creating methods in ChromLab, see the NGC 

Chromatography Systems and ChromLab Software User Guide.

To set up a method that uses the autosampler

1. In ChromLab create a method that includes the autosampler in the fluidic 

scheme. The Sample Application phase automatically displays Inject Using 

Autosampler.

2. In the Sample Application phase, increase the injection volume to include the 

total volume of the installed autosampler loop and the tubing needed to 

connect Port 6 on the autosampler to the Loop F port on the sample inject 

valve.

Tip:  Typically, a sample loading volume of 2–3 ml should be sufficient to 

completely load the entire sample in the autosampler loop onto the 

column.

3. Use the front panel on the C-96 autosampler to create a method.

See the C-96 Autosampler for BioLogic DuoFlow Chromatography System 

Quick Start Guide or the C-96 Autosampler for BioLogic DuoFlow 

Chromatography System User Manual for more information.

4. Start the autosampler method and place the autosampler in REMOTE mode.

5. In ChromLab, complete the method setup and start the run.

For multiple samples, perform a multi-run of the ChromLab method. The number of 

runs (in the multi-run) should correspond to the total number of injections (from the 

same vial or multiple vials) to be programmed on the autosampler.
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The NGC instrument has been tested and found to be in compliance with all 

applicable requirements of the following safety and electromagnetic compliance 

standards. The NGC instrument is labeled with the following compliance marks.

Safety Compliance

CE Mark:

 EN61010-1 Electrical Equipment for Measurement, Control, and 

Laboratory Use

 IEC 61010-1 Safety Requirements for Measurement, Control, and 

Laboratory Use, Part 1: General Requirements

cTUVus Mark:

 UL STD No. 61010-1 Electrical Equipment for Measurement, Control, and 

Laboratory Use, Part 1: General Requirements

 CAN/CSA C22.2 No. 61010-1-12 Safety Requirements for Measurement, 

Control, and Laboratory Use, Part 1: General Requirements (includes 

Amendment 1)

Products with these safety compliance marks are safe to use when operated in 

accordance with the instruction manual. This does not extend to accessories with 

no marks, even when used with this unit.
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Sample Loop PSI Ratings for U.S. and Canada

The following pressure ratings are required specifically for U.S. and Canada 

applications. Bio-Rad recommends using these ratings to reduce the 

volume-pressure product of the column load liquid path in order to maintain 

compliance with UL61010-1:2012 and CSA C22.2 No. 61010-1-12.

Electromagnetic Compatibility (EMC)

CE Mark:

 EN61326 Class A Electrical Equipment for Measurement, Control, and 

Laboratory Use, General Requirements

The NGC instrument is designed to operate in a controlled electromagnetic 

environment. Do not use radio transmitters within 10 ft (3 m) of the instrument.

Table 25. Sample loop PSI ratings for U.S. and Canada applications

Injection Loop Size Pump Size Maximum Pressure 
Rating

5 ml F10 2,650 psi

5 ml F100 1,400 psi

DynaLoop 25 ml F100 700 psi

DynaLoop 90 ml F100 270 psi
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FCC Warning and Notes

The NGC instrument complies with part 15 of the FCC Rules. Operation is subject to 

the following two conditions: (1) This device may not cause harmful interference, 

and (2) this device must accept any interference received, including interference 

that may cause undesired operation. 

It is possible that emissions from the NGC instrument may interfere with some 

sensitive appliances when placed nearby or on the same circuit as those 

appliances. The user should be aware of this potential and take appropriate 

measures to avoid interference.

The NGC instrument should not be modified or altered in any way.

Alteration of the NGC instrument will:

 Void the manufacturer’s warranty

 Void the IEC/EN/UL/CSA 61010-1 safety compliance

 Create a potential safety hazard

Bio-Rad Laboratories is not responsible for any injury or damage caused by the use 

of this instrument for purposes other than those for which it is intended, or by 

modifications of the instrument not performed by Bio-Rad Laboratories or an 

authorized agent.

Important: The NGC instrument is intended for laboratory use only.

We strongly recommend that you follow the safety specifications listed throughout 

this manual. Use only the supplied power cord with the instrument, making sure to 

choose the plug adapter that corresponds to the electrical outlets in your region.
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F NGC Chromatography 
Systems Catalog Numbers
Table 26.  NGC chromatography systems catalog numbers

System Catalog number

NGC Quest 10 788-0001

NGC Quest 100 788-0002

NGC Quest 10 Plus 788-0003

NGC Quest 100 Plus 788-0004

NGC Scout 10 788-0005

NGC Scout 100 788-0006

NGC Scout 10 Plus 788-0007

NGC Scout 100 Plus 788-0008

NGC Discover 10 788-0009

NGC Discover 100 788-0010

NGC Discover 10 Pro 788-0011

NGC Discover 100 Pro 788-0012

NGC Fraction Collector 17002070

BioFrac Fraction Collector 741-0002

NGC Autosampler without Cooling 788-5011

NGC Autosampler with Cooling 788-5012

Signal Import Module (SIM) + Autosampler Cable 788-4016

Communication Adaptor 788-4025
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G NGC Chromatography Systems 
Warranty Information
The NGC chromatography systems are warranted for one year against defects in 

materials and workmanship. If any defects should occur during this warranty period, 

Bio-Rad Laboratories, Inc. will replace the defective parts without charge. However, 

the following defects are specifically excluded:

 Defects caused by improper operation

 Repair or modification done by anyone other than Bio-Rad or its 

authorized agent

 Defects caused by use with fittings or other spare parts not specified by 

Bio-Rad

 Damage caused by deliberate or accidental misuse

 Damage caused by disaster

 Damage due to use of improper solvent or sample

 Tubing and fittings
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